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Reinforced Concrete Building

=Step 1: Initialization of workspace

= Step 2: Material & Section Properties

Input Overview
This example problem is meant to demonstrate the design of a Reinforced Concrete building
(G+13 Floor + Terrace + 1Basement Podium) structure which is located in Agra is subjected to

=Step 3: Generation of floor layout floor loads, wind loads and seismic loads

= Step 4: Generation of Model Wind Design Data
Basic wind speed 47 m/sec
=Step 5: Boundary Conditions Terrain Category Il
Building Class A

»Step 6: Loading Data Input
Seismic Design Data

«Step 7: Analysis -Dual system (special reinforced concrete structural walls with special moment resisting
frame) in both the directions
= Step 8: Verification of Reactions, -Assigned to a seismic zone Il (Z=0.16)
. -Soil Type I (Medium Soil)
Displacement and Member
-Importance factor 1.2

Diagrams -Response Reduction factor 5.0

=Step 9: Story Checks

= Step 10: Design Input & Output Methodology
-Response spectrum analysis

Program Version Gen 2026 (v1.1)

Revision Date 18/07/2025
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Step
Overview

Figure 1: RC Building Model 3D
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Step

00 Typical Floor Plan
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Figure 2: Typical Floor Plan
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Step

1[IN Podium Floor Plan
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Figure 3: Podium Floor Plan
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Step
Elevation View

14%x3m = 42m

2X3 m=6m L J

Figure 4: Longitudinal Section
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Step

1[IN Details of the Reinforced Concrete Building

Applied Code . Materials |
RC Design Code : Concrete M30 For Beams
IS 456-2000 Concrete M40 For Columns
Concrete M40 For Walls
Steel Fe415
Building Structure Elements Applied Load
Section ID Dimension Description Load Description Intensity
_ Dead Load Self Weight
! 450x450mm Podium columns Tvpical Floor Load Super imposed Dead Load 4 KN/m2
— yp Live load 2 kN/m2
2 300x800mm Building Columns -
: Super imposed Dead Load 4 KN/m2
Podium Floor Live load 4 kN/m2
3 230x700mm Beam
Roof Floor Super imposed Dead Load 5.5 kN/m2
4 230mm thick Walls Live load 1.5 kN/m2
Wind Load X, Y direction IS 875 Part3
Earthquake Loads X, Y direction IS 1893-2016
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Step

Ik 1-1.Initialization of workspace

Procedure

Starting Midas Gen

Bﬂew Project... :

[== Open Project...

Recent Documents
@ Click on GEN icon > New Project

Close Project

@ Check the units on the lower
right corner of the screen.

Project Information

View Structure Node/Element Properties Boundary Analysis Results Pushover Design Query Tools
(@) staticLoads|  (©) Seismic (©) settiement/Misc. % & self Weight - Nodal Body Force | € Wind Loads Jie =7 Initial Forces ~

N =-
& -

(!5 Nodal Loads ™ Loads to Masses ~ | ¥ Seismic Loads

BEIBE

(2) Temp./Prestress (7) Construction Stage (7) Load Tables
StaticLoad Using Load
(D) MovingLoad  (7) Heat of Hydration

Cases  Combinations | 4 Specified Displ.

Lo

Message Window

Your maintenance period expires in 315 day(s).

Sill=E@008 09 :

Tree Menu [REHELT

>>
{4171\ command Message /i Analysis Message [ <&

Display Element Numbers None! U:0,0,0

=
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Step

1EB 1-2.Setting UCS to XY Plane

Procedure

Structure Tab > UCS/Plan >
UCS > X-Y Plane

Load

Node/Element Properties Boundary Analysis Results

*/# Check/Duplicate Elements
E Display Free Edge/Face ~
#, Check Element Local Axis

ﬁ@ Structure
oL BT -
%L Change ~

1 3 .
1 :H Dimension
o

224 Grids ~
Named Plane

Control

@ Set UCS to X-Y Plane > Origin Structure Control

Type
0,0,3
@ Click on Apply And OK

Structures~

Define User Coordinate System-({MIDAS/Gen) >
Three Angles | MNamedPlane | UCSbyUCs | Named UCS
X-Y Plane | %ZPlane |  Y-ZPlane |  Three Points
‘9&@'&@9 _______________ |
I':J'l_'l'ﬂl'l___u;ﬂ_rf ____________ } m " "
O &,
Rotation Angle ey
Angle: 0 - [deq)
[ Adtivate U5 Plane [ ] Change View Direction
Save Current UCS Y:::EEK::::: Apply Close
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Step

1kM 1-3. Generation line grid

Procedure Define Grids-(MIDAS/Gen) X
Generate the required gridline system Properties e @
Structure Tab > UCS/Plan > Grids m % hucs-  HDimension | CurentGid: B Chad |
feee = ——
t H : I ooy Grids -
> Define Line Grid > Add Structure Base Control L""-I
Type Named Plane
UCS/Plan
o Add :
(0]4 Apply Close
@ Name it Global,
Grid Lines X Add/Modify Grid Lines X
. AN/ -
® Add X grid lines @ e Qe __ cidname: 1 Goba ]
\"r_ . 1304 1 T
e R | ¥-Grid Lines Y-Grid Lines
e Relatlve Example : -5.0, -3.5, 4, 6@3 ( Ex : 5@3 results in 5 grid lines at the spacing of 3 ) 0(0)
. | 0K | Cancel
Lines: 13@4
(13@4,Means 13 Grid lines at the o e
spacing of 4m) \7_3.11_?] Modfy ~Del  DelAl | ‘“_-“1-= Modify = Del | Del Al
\ 6 B I
\{_ _OE __ J.I Cancel
@ AddY grid lines and
Relative Lines: 2@4,6,4,6,2@4 ‘
® Click OK

A dialog box depicting the
Gridlines appears. Click OK
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Step

1¥4 2-1. Defining the Material & Frame Section Properties

Procedure

Defining Material Properties ‘Vew Structure Node/Element Properties Boundary Load Analysis Results Pushover

@ Functions Change Property - 13
Properties Tab > Material > Material H < E] @ @@ Cf

[} Creep/Shrinkage %@]Material Link
i Material Plastic Section Scale Tapered Thickness
Properties Properties Comp. Strength Material | Properties Factor~ Group

Material

.rl—y[ Inelastic Hinge ~
Group Damping ~
Inelastic Material ~

O Add

Material Data x

Properties ot (E—r]
. Material | Section | Thickness | o Heteral 10 ' ome =
@ Type of Design: Concrete e 2 eee—
ID Na.. Type Stand.. DB L_ Add.. | g/vpe of Desion Conarete M ==
Standard: IS(RC) Mody.. m—mmmmmammea | S

DB
Delete ? Show only Strand
DB: M3O Product

Copy I Conarete 1
1 Standard  1S(RC) 1
Import Type of Material : o |
. Renumber © Isotropic Orthotrapic . 1
®© Click OK 1os (e !
Steel e o o o o o e ———
Modulus of Elastidity : 0.0000e+00  jiN/m=
Poisson's Ratio A o
. . . . effi . 0.0000e+00
Similarly define M40 material Thermel Cosfficent i
Weight Density - 0 knjm2
se Mass Density 0 N
property for columns and walls TG Sl
B concete
Modulus of Elasticity : 2.7386e+07  yyjm2
Close Poisson's Ratio : 0.2
Thermal Coefficent : 5.5556e-06 4 rF)
Weight Density - 236 kNjm?
[ Use Mass Density: 2407 knjm*fq
Plasticity Data

Plastic Material Name NONE

Inelastic Material Properties for Fiber Model & Non-dissipative element
Concrete None v Rebar None

Confined Concrete for Columns None

Thermal Transfer

Specific Heat E o Btu/kN-[F1
Heat Conduction : 0 Btu/m-hr-TF1
Damping Ratio : U3
1 oK 1 Cancel
=
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Step

1¥4 2-1. Defining the Material & Frame Section Properties

CerdaE

Defining Frame Section Properties View Structure Node/Element Properties Boundary Load Analysis

H {3} Functions Change Property D . @ @@ C;j

ﬂ Creep/Shrinkage Material Link

Results Pushover Design

..»'—y' Inelastic Hinge ~

Properties Tab > Section > Section Group Damping ~

Pr i > A Material Plastic Section | Scale Tapered Thickness | — . v
operties dd Properties Comp. Strength Material | Properties Factor' Group Inelastic Material ~

@ Solid rectangle

Name: Podium Column Secton Dats «
| Section Name Dimension
DB/ User

--------- Podium
=l WA Soid Rectangle 1 v Podium Column 450x450mm

9 l:ise(; 45 Name Podium Column °L:Er---D-B---|‘ ;OIIL:jmn

=0.45m :

- treing Building Column 300x800mm

B=0.45m column
Beam Beam 230x700mm

© Click [Apply]

ity
Similarly define the other Frame LB___DiS___.!'
Section Properties
Building Column 300x800,
Beam 230x700.

" ommom Dt e )

O~
Show Calculation Results.. Cancel
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Step

1¥4 2-1. Defining Shear walls

CeraaE

Defining Shear waIIs View Structure Node/Element Properties
Properties Tab > Section > Thickness

Boundary Load Analysis Results Pushover

. ====
H {#}] Functions [E Change Property Ilﬁlj @ @@ = / Inelastic Hinge ~
1 =
reep/Shrinkage aterial Lin 1 r— Group Damping ~
> Add Creep/Shrink Material Link T Group Dampi
Material Plastic Section  Scale TaperedjThickness] — i y
Properties Comp. Strength Material lnelastlc Material ~

@ For the Shear Walls
And Slab Thickness:

. i , . Thickness Data *
Add a ThICkneSS SeCtlon Thickness Data X
Value Value |Sliﬁened| Properties a x
----------------------- L |
In-plane & Out-of plane= 0.23m orhick’"’“m L R 7= Material | Section Thickness
| ' (2)
- o . I L ./ —
Lo—lujlﬂe—&gm—ﬂf—plaﬂ)———ofi—-—-—ﬂ———-l {515~ Name Type Thicknes... Offset 1 Add...
O g 0 . L Shear..  Value 0230000 No ‘l =
@ On creating the wall, it is Outof pane 0 m —
elele
Displayed in the dialog box () hate Offset Copy
Thickness Ratio Import
localz O Renumber
Value
Local z 0 m
Close
Show Calculation Result. Cancel Apply
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Step

1K 3-1. Generation of Floor layout

Procedure r——— B x

MNode FEEuENSE EBoundary Mass Load

Generate the Beams

Node/Element Tab > Create |create Blements -
Elements [—Jstart Number
Mode Mumber @ 1 E]
@ Select General beam/Tapered Bementhumber: 1 [
beam 1
' | General beamTapered beam -
@ Make sure that Intersect at z (Ref-
| %

nodes and Elements is on

¥ Vz
To create a beam, click on nodal ha

M1

connectivity and select the origin
as the first point and draw till ‘

the last point.

[HD <
4

IMaterial 4
: Ma. Mame :
I =
e :
1 Mo. Mame 1
e o) )
Orientation
(@ Beta Angle (7 Ref. Paint
() Ref. Vector
o ¥ [ded]
Modal Connectivity
[T orthe
*Please make sure that
. . . Intersect:  [¥|Mode  [V]Elem E]
POInt Grld Snap 1S On Create Inter og Modes =
? o | i
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Step

1K 3-1. Generation of Floor layout

P r ocedure Properties  Boundary Load Analysis  Results Pushover Design  Seismic Performance  Query  Tools
. » - X Delete +|* Mirror ¥, (7] y (£ — 1 X Delete ;% i Effective Beam * olumn Capital * 0-mesl ine Sub-Domain
NOde/EIement Tab > DIVlde b - = %\g. :.: D :olla:e “'I*":cale 3 ‘ L I' = _‘ L-'I-:‘{- [%ﬂ ‘_'zo:alle (I} E}I ;:\ :nn:lr = T - %::-mes: e
Create | Translate Divide Marge - ~ | Nodes | Create —  Translate Extrudd Divide MBrge Intersect - . Change  Elements Y e g
Elements Nodes & Project & Table | Elements - [| Mirror 4] ' Parameters  Table | " Drop Panel - Fim Define Domain
EFEEFFEEREFL LR -
@ Click on select single o _____________________ .
i Divide Elements ull [ 1
I
| (2 Start Number !
: Node Number - 115 :
I
@ Select the elements as | Element Number : 209 :
shown in the figure ' : e
I Divide : . < .
: Element Type : i i
@ Click Unequal distance i Oframe () Solid : : :
I Cwall () Planar I i i
. 1 = = = e
Element type : Frame i :
. 1 () Equal Distance i
- I -
Distance : 4 m I © Unequal Distance : Mﬁ
' e
. I () Parametric U | Dista !
e Click apply A rametric Unequal nce I
1 (! Parallel Bracing :
(.
e E L LR P LT | 1 () Divide by Node |
:NOte ' | Divide by Pattern : 1
I
. I
iDepending upon the local | N 4 m :
1 ! I 1
laxis from " and j** of the | : :
I . ! i [
X - - (N SN IS S S S E— S S— — S - 1
:element the offset distance ' | (Bample: 53,45, 3@5.0) : -
I I
:can vary as 2or4 m. 1 : Subdivide Frame Elements 1 —
o o o o o o e - 1 1 1 — 1 |
I . Merge Duplicate Nodes :
e o o o o e e e e e e "
= iy, 2 Close &
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Step

IXN 3-1. Generation of Floor layout

Procedure r——— B x

MNode FEEuENSE EBoundary Mass Load

Generate the Beams

Node/Element Tab > Create |create lements -
Elements [—Jstart Number
Mode Mumber : 1 E]
@ Select General beam/Tapered Bementhumber: 1 [
beam Qe _________
| General beamTapered beam - e
1
1
i
@ Make sure that Intersect at z (Ref-
nodes and Elements is on 7
y\/ﬁz p
To create a beam, click on nodal = =

connectivity and select the origin
as the first point and draw till ‘

the last point.

o= ===========n :
: i Mame :
| =
: sm‘ : ..........................................
1 Mo Mame
L =
o o o o o st =
Orientation
(@ Beta Angle (7 Ref. Paint
(7) Ref, Vectar
o ¥ [ded]
Nodal Connectivity
[T orthe
Intersect: MNode Elem E]
Create Inter og Modes %
2 o |
L

www.MidasUser.com



http://www.MidasUser.com/

Step

1K 3-1. Generation of Floor layout

Procedure
Node/Element Tab > Divide

]

Results

Pushi ve. and Seismic Performance Query Tools

w_K Xpelete o il effective Beam * Y Column Capital = | [l Auto-mesh Him Define Sub-Domain

y e E @ — X pelete 7
. L] %\Q. "'.“ “%Rotate S scale ¥ 2 I _‘ ".‘ ﬂ [SF x U:o:atte IL: E}' :\P &l column strip - IE] Map-mesh
Elements %‘I:;g fronsiate Dlwdeoq gPrujed -f ':‘l:glees EE?\:l"els " Transiate Extrude ST 1% Mirror £. PacI:i?egl:rs E‘?fa"E:'s 1Dr0p Panel - EDeﬁne Domain
@ Click on select single o _____________________ |
i Divide Elements il P 1
I
I
1 (B start Number :
I
1  Mode Number 118 : ..................... Ui S N | N | | ——
I
@ Select the elements as | Element Number : 215 :
shown in the figure ' i e
I Owide ]
|  Element Type : 1 1
. . 1 ~
© Click equal distance | Oframe () solid ! i |
1 '.\_,'WHI :_-_.‘I Planar I % 4 P 1 o % p
Element type : Frame : I Lol
. 1 Q) Equal Distance :
1
Equal Distance I Unequal Distance : _
Number of divisions : 2 1 () Parametric Unequal Distance :
: (") Parallel Bracing :
@ Click apply ! ) Divide by Node : |
! Divide by Pattern !
I = Ve
: Number of Divisions x: 2 - :
z I
- 2 3 I
i I
I X 15 1
' : Va M F
I
: Subdivide Frame Elements : /A
: .Mgrgg Duplicate Nodes : - S — S T . —
ey A Ve 1 N
1= Rpply. o Close =
[ @ :h,q
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Step

1K 3-1. Generation of Floor layout

Procedure r——— B x

MNode FEEuENSE EBoundary Mass Load

Generate the Beams

Node/Element Tab > Create |create Blements -
Elements [—Jstart Number T
Mode Mumber @ 1 E]
@ Select General beam/Tapered Bementhumber: 1 [
beam Qoo _________
' | General beamTapered beam -
R N - ‘
1 1
@ Make sure that Intersect at 2 ( Ref. i '
| - X -TTTTT

nodes and Elements is on

¥ Vz
To create a beam, click on nodal ha F _

M1

connectivity and select the origin h
as the first point and draw till ‘

the last point.

I Material 1
: Ma. Mame :
| e
1 Mo. Mame 1
s =
oo o e et =
Orientation
@ BetaAngle (D) Ref, Point
(7) Ref, Vectar
o] * [deg]
Nodal Connectivity
[T orthe
[
Intersect: MNode Elem E]
Create Inter og Modes
Yool | |
L
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Step

1K 3-1. Generation of Floor layout

Procedure Tree Men -

Load
Generate Columns o
View Tab > Grid/Snap > /...
UCS/GCS > Click GCS

Node Number  : 967

Element Number : 2065

Extrude Type

€@ Node/Element Tab> e
Extrude Elements

Mode -> Line Element

1 i
1 1
I 1
1 Source Remowve Move 1
: [ Reverse 1-1 :
() Node to Line elements, I Element Attribute 1
: Element Type: Beam 1
select Element Type as 1 Materia: '
1 2 2: M40 1
Beam ! | Setin: !
L 1 1: Podium Column 1
Beta Anale : 0 [Deql
€ Translation Distance as 0,0,-3
Along Z axis. :;‘
Generation Type .:l' =
O Translate () Rotate () Project
@) Select all the nodes as shown Translation
in the figure gEquaI Distance
() Unequal Distance
oot 003 1
dx dy dz* 0,0 -3
L _di et
. Number of Times: 1 &
@ Click on Apply

erging Talerance
[ E—
L Apply 1 Close
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Step

1K 3-1. Generation of Floor layout

5 - - . - 5 g B @ g @ 8 o o} free Menu 2

Menu Tables Group i
Procedure R Mt s it At st Mgl St et St . o Aosign
= = Works

________________________ -
. 1 Select
Modify the Property of Columns: I £ S S A oy ot -
. 1 i Eiger walue Ar lay‘S'S -
( To Change the property of certain ! "  £3 Structures Unselect
exterior columns to Interior) - B B R i : Bt & ¥ Stories : 17 Unselect Al
1 I * . Nodes : 964 o]
1 N AU AU ST S AN SO [T # ",* Elements : 2064 Lelle ]
: 1 [] Properties Active Plus
. . [ oy .
@ Works> Properties > Section I i o [ gaterial - 2 Inactive
) . FER—- :: P S — T T I S S ACHOR 2 Active Al
>Podium Column>Right = F====—s—ss—mm—oo———e——ee ! E 1 _Podium Column ! -
) ) o & B B “ o @ s a a & b o a 2 Buiding Columnl =l
C“Ck > ACtIVG ;‘ :3"833‘-“---- Properties
®[ 0. o o B o a o a 8 o o o =] &« Thickness : 1
PC 4{94_\(-150 PC 45{9.‘(450 PC 45&\(450 PC 459.‘(450 PC JSE,‘“SO PC JQQXJSO PC 4%),‘(450 PC 459_,‘(450 PC 459’,‘(4:0_1’(-‘:;9_‘,‘(450 PC JS?XJSO PC 4_‘&&!50 JS&XJSO PC JSLQXJSO
@ Select the columns whose
property haS to be Changed PC wadsﬂ PC -i?QXHO PC 450;(450 PC 456X450 PC 4.?0?(-150 PC 456X450 PC 450}{450 PC 45(),‘(450 PC «150?(4150 PC 45:@‘(450 PC 450X450 PC .1.‘.)&‘,‘6150 56X450 PC 456X450
as shown in the figure.
. . PC 456X450 PC 45_)&345' C300X800 CSO(‘)XSOO C300X800 C30'ﬂ(800 C30(:n‘(800 C300X800  C300X800  C300X800] PC 4§Q.Y~150 PC 4$QrY-I50
View Tab >Display >Property ! '
1 1
> Property Name I [
1 1
1 1
9 Now from the Works Menu, PC 450X450 PC 450X450 C300X800  C300XB00  C300X800  C300X800  C300X800  C300XB0O  C300X800  C300X800 : PC 450X450 PC 450X450
1 ‘ 1 ! ,
: 1 1
Drag and Drop Interior I [
BUIldlng Column section PC 450X450 PC 45@(45: C300X800  C300X800  C300X800  C300X800  C300X800  C300X800  C300X800  C300X800 : PC 450X450 PC 450X450
' ] j A ! , 3 "
1 1
1 1
1 1
' :
1
PC AWX45O PC 450.‘(45. C300X800 C300X800 C300X800 CJO({XSOO C30€q(800 C300X800  C300X800 c300x800l pPC 450‘,‘(450 PC 4§q,Y450
R é f i i
[ SN SN S N SN NS S | S (S [

PC 436X450 PC 439X450 PC450X450 PC430X450 PC430X450 PC 436X450 PC 430X450 PC 450X450 PC 430X450 PC 430X450 PC 439X450 PC 436X450 PC 430X450 PC 430X450

I~
PC AL#-XSQ \PC 450X450 PC 430X450 PC 450X450 PC 450X450 PC 430X450 PC 430X450 PC 456X450 PC 450X450 PC 430X450 PC 430X450 PC 430X450 PC 456X450 PC 450X450
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Step
3-2. Generation of Shear Walls

Procedure

Generation Shear Walls

@ Select the elements as
shown in the figure

@ Extrude type : Line >
Planar element
Check in Remove to
remove the line elements
selected
Material : M40
Thickness : 0.23

@ Generation type : Translate
Distance : 0,0,-3

e- JReverse ) L,

Extrude Type
Line Elem. - Planar Elem. w
Source @ Remove [ |Move

Element Attribute
Element Type: Wall et
Material :

2 2: M40 vl ..
Thickness :

1 1:0.2300 (Shear wall & ~ ...

© Membrane () Plate
walllD: 1

[m=——————————————

: Genn~ration Type

| ©Translate ()Rotate () Project
1

1 Translation

1

1 @) Equal Distance

1

I (") Local Direction
dw,dy,dz; 0,0,-3 m

|

1

1

1

1

1

1

1

1

: () Unegual Distance :
1

1

1

1

1

1

Number of Times : 1 :
1

1

1

[mm———————

Merging Tolerance

Apply | Close
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Step

18 4-1. Generation of Building Model

Euilding Generation

BU|Id|ng Generation View Structure Node/Element Properties Boundary Load Ana
Start Mode Mumber @ 417 E] @ C\i Dynamic = @View Point = ] Egs:e-ct-v:
s - . T ———
VieW Tab > SeIeCt > SeleCt A” Start Element Number : 1009 E] Redraw Initial Previous k\lZoom . Hamed View @ k passied S
Building Generation View  View 4 7Pan - Select Previous —
o —— — — iew Rende
1 : 1 =21
@ Structure Tab > Control Data jlumber of Coples i
LDisiance{GlobaI ) 3 m :
Building Generation R e
No of COpieS: 1 Column SectionIne. : O (=
. ) .0 =
Distance (Global Z): 3.0m BeamSectoninc. = ~ O
Brace SectionInc. @ 0 [

wall ThicknessInc. : 0 =

i
0
i

, e e e N T
@ Click Add cerations e RpNESES S
= My o Y= e -5-“."‘.';- <P
: e e e T T
| Add | Pt P N [y e BT
Pl ~L!_=‘;E!.'-".§"‘--g~.=};,
© Click on Apply Copy Dist(m)  Mat G S i
1 3 0 0 !
The building is generated as
Shown
(podium is only up to two levels) < om ] b

[ Building Generation Table

|
Copy Mode Attributes E]
Copy Element Attribute E]
-]

|

Copy Building Attribute

Merging Tolerance

F] Apply I Close

Tree Menu

www.MidasUser.com



http://www.MidasUser.com/

Step

04

Procedure

4-1. Generation of Building Model

Properties

Boundary Lload Analysis Results  Pushover Design Seismic Performance

8 1A I =

Query

@ View > View point > Rear (+Y) [ [[ 1] [em & Oymemc iglenion " Select - (LS ucs/ecs -

..@

Zoom ~ " Unselect 883 Grids ~
Redraw Initial Previous * H @ 0 O Active Inactive All Inverse | °°° Display
View  View @Pan 4 Top (+Z) Ctrl+Shift+T @Select Previous * v  Active g{g Snap -~ v
@ Sclect elements as shown @) totom (2 cusvi-s Y ,
EMIE Select Previous e
ety H) Left -x Ctrl+Shift+L - e ey
(it I [iﬂ[z 2k - [ SR ) | " 235to350 |& "W 323to634 ;‘_:ﬂ wekss 3o «ol
® Click on Active BLret O — o o ClfShiteF
U Rear (+v) Ctrl+shift+£ 1
_(& Angle
o Rotate Left Ctrl+Alt+Left
d. Rotate Right Ctrl+Alt+Right
+* Rotate Up Ctri+Alt+Up
&8 Rotate Down Ctrl+Alt+Down
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Step

18 4-1. Generation of Building Model

Building Generation

Building Generation

Start Mode Mumber @ 417 E]

View Tab > Select > Select Start Element Number : 1009 [,
by single > Select ground floor Buiding Generation_____.,
as shown T : Number of Copies : 14 = :
LDisEnce{GIobaI e 3 m :
Material Inc. : D &
@ Structure Tab > Control Data — 1

Column Section Inc. :

> Building Generation

Beam SectonInc. : 0 =
No of COpieS: 14 Brace SectonInc. : 0 =
Distance (Global Z): 3.0 m Wall ThicknessInc. = 0 [~
Uperations
@ Click Add
Copy  Dist.(m) Mat. C
14 3 a a
. e e
© Click on Apply o .;?_‘:":El}."!.'

L

A
A

Uik
/1

@ The building is generated as

I('_

hAd
v/

< | 1 | 3

i

Shown

[ Building Generation Table :_.:_::-'-Igl
=
Copy Mode Attributes =

i
/1

A
/Y

oA
Al

'
7

Copy Building Attribute

Merging Tolerance
[~ Apely i Close

Tree Menu

L

Al
i

A

)

-]

Copy Element Attribute E]
(-]

]
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Step

18 4-2. Automatic generation of the story data

Procedure

Structure Tab > Control Data >
Story

@ ciick [Auto Generate Story Data]
button. This will create the data
needed to generate diaphragms
for each floor

@ Click [OK]
Story data is generated

Story Data

Ground Level
0|

& m

Module [smry Name | Level(m) |Height(m)| _ Floor

*

) |\ Story {Wind {Seismic/
____________ 2
[ Auto Generate Story Data... 1 Define Module.. Calculate Acddental Ecc. Close
Automatic Generation of Story Data *
Unselected List Selected List
N. Level N. Na... Level Height
1 1IF 0 3
2 F 3 3
3 3F 6 3
> 4 4F 9 3
5 5F 12 3
6 6F 15 3
7 T7F 18 3
<- 8 B&F 21 3
9 9 24 3
10 10F 27 3
11 1IF 30 3
12 12F 33 3
13 13F 36 3
id i4F 0 k]
8 Include Seismic Acddental Eccentricity : 5 % of Plan Dimension
B Include Wind Eccentricity : 915 9% of Plan Dimension

T} oo
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Step

1N 5-1. Boundary Conditions

Procedure

The lower ends of the Columns
are assumed fixed
Click E “Select by window”

Tree Menu

MNode

o x

A0 Boundary EEEREEET]

Boundary Group Mame

[Defﬁult - ] E]

|
| 1
|
@ Add  ()Replace (7 Delete o-__:--_;'__;'-_;'__';-_';_r-;__-7__-7-__7-__7-__:-__ _=
1

@ Select the ends of all the columns _
Options
from the Front view.
1
Support Type (Local Direction) L __________________________________________
@ Boundary Tab > Supports >
Define Supports % Ry D ol
. Rx D
€ Select the property of Fixed Bz “E
Support i.e. D- all, R- all. Dz % gty

DnyDz

|
i H ) | I | I | | 7 7 7 | 7 l
@ Click on Apply === |

T7RAL"! ® & & & ¢ ¢ 66 & ¢ o 6 & ©

F‘.xF‘.yF‘.z
Rw [V
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Step

1[iW 6-1. Load cases

Procedure

Load Tab > Load Type >
Static Loads > Create Load Cases
Static Load Cases

€ Add the loads and their details
as shown in the Dialog box

@ Click : [Close]

View Structure

Node/Element Properties Boundary Analysis Results Pushover Design Query Tools

@ Static Loads O Seismic O Settlement/Misc. & Self Weight ‘\"o- Nodal Body Force | §F Wind Loads 1 Element
O Temp./Prestress O Construction Stage O Load Tables G; Nodal Loads ™ Loads to Masses ~ | §f Seismic Loads | [T Line

Static Loadl Using Load

O Moving Load O Heat of Hydration Cases ICombinations :l Specified Displ.
——

Structure Loads / Masses

A Typical

Beam Load

Static Load Cases X
m 0 ..
Name 3 | _A_dd_ - —I
Type : Dead Load (D) v Modify
Description : Dead Load Delete

No| Name Type Description
»| 1L
2LL  |Live Load (L) Live Load
3/SIDL  Dead Load (D) Super Imposed Dead Load
4WX  Wind Load on Structure (W)  Wind Load in X Direction
5WY  Wind Load on Structure (W)  Wind Load in Y Direction
6EXP  Earthquake (E) Earthquake Load in X Direction
7EXN  Earthquake (E) Earthquake Load in X Direction
8EYP  Earthquake (E) Earthquake Load in Y Direction
QiEYN {Eanhquake (E) Earthquake Load in Y Direction
I _Cose
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Step

1[¢8 6-2. Loading Data (Self Weight )

Procedure

Load Tab> Load Type >
Static Loads > Structural Loads/

View Structure Node/Element Properties Boundary Analysis Results Pushover Design Query Tools

O Seismic O Settlement/Misc. - §H wind Loads
------ M

O Temp./Prestress O Construction Stage O Load Tables U Nodal Loads ™ Loads to Masses ~ | §f Seismic Loads | [T Line
StaticLoad Using Load
O Moving Load O Heat of Hydration Cases Combignations :l Specified Displ. A Typical

Structure Loads / Masses Beam Load

M Element

Masses > Self Weight

Tree Menu

@ Load Case Name: DL

Mode Element Boundary Mass ree Menu

Z=-1 [SeIFWeight v] N Menu Tables Group VG

3 Works
a [ Analysis Control Data

Load Case Name

E] P " Eigenvalue Analysis [ Type.Eigenvec
g Add Load Group Name Structures
= = 5] Propetis
Self Weight Factor ?:::Ii:‘:ll §
® In the Work Tree menu, Self e B2 Thdews 3
i i i B J_ Eoundanes
Weight will be displayed . 4 A gt 116
Téj ' gt X B 6 ‘Masses
X . @M Loadsto Masses : 3
Demunans_ ___________
0 n|ﬂ Static Load Case 1 [DL ; DEAD LO'
o."__“ _________ . L Seff Weight [571] [
(N | [#-[L]) Static Load Case 2 [LL ; LIVE LD...
Load Casenm s bt 2 [ Grop Static Load Case 3 [SIDL ; SUPER |
= D o e Static Load Case 4 WX ; WIND LO/
[+-[u]l Static Load Case 5 WY ; WIND LO/
o]l Static Load Case & [EXP ; EARTHQ!
P e — #-[L]l Static Load Case 7 [EXN ; EARTHO
9 o ation #-[L]l Static Load Case 8 [EYP : EARTHQI
[+-[L]l Static Load Case 5 [EYN ; EARTHQ
:j m M =I8 fl-‘ Response Spectrum Analysis
% Response Spectrum Functions : 1
Response Spectrum Load Cases : 2
= El Rebar Data
(i Wl

Tree Menu
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Step

1[¢M 6-2. Loading Data (Floor Load)

Procedure

Load Tab > Initial Forces/Misc
> Assign Floor Load Type > Define

floor load type

@ Name: Typical Floor

DL: -4kN/m2 (Consider 100mm
slab thickness, self weight
added)

LL: -2kN/m2
@ Click on Add

Similarly define these floor loads
Name: Podium Floor

DL: -4kN/m2
LL: -4kN/m2

Name: Roof
DL: -5.5kN/m2
LL: -1.5kN/m2

View Structure Node/Element Properties Boundary Analysis Results Pushover Design Query Tools

@ Static Loads O Seismic O Settlement/Misc. _I \“" Self Weight \\u‘_ Nodal Body Force Eﬁ Wind Loads Tl Element ﬁl Pressure Loads
________
OTemp./Prestress O Construction Stage O Load Tables G; Nodal Loads \M Loads to Masses ~ 'iﬁ Seismic Loads | [T Line h Hydrostatic Pressure

Static Load Using Load

(©) Moving Load Cases

(7) Heat of Hydration Combinations | .. Specified Displ. M Typical | 44 Assign Plane Loads ~

Floor Load Type x
Foor Load Type Ng@M& Description
Name AT TR
Description :
Floor Load & Load Case
Load Case Floor Load
1. SIDL v || -4 . kN/m? B 5ub Beam Weight
2. L v -2 ... kN/m2 | Sub Beam Weight
3. NONE v [ kN/m? Sub Beam Weight
4. NONE il L. . kN/m2 Sub Beam Weight
5. | NONE v| 0 kN/m? Sub Beam Weight
6. | NONE | 0 . kN/m2 Sub Beam Weight
7. | NONE ~ | 0 kN/m? Sub Beam Weight
8. | NONE ~| 0 ... kN/m2 Sub Beam Weight

Define Load Case...

Namea Description L 1
Typical Floor Modify

Podium Floor
Roof Delete

-

Close
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Step

1[¢M 6-2. Loading Data (Floor Load)

Gen 2015 - [D:\01_Technical\01_Gen\05_Steel_Struc

Procedure

View Tab > Activities > All > Active

Structure Node/Element Properties Boundary Load Analysis Results Pushover

|dentity m r—:—] @ Q¢ Dynamic ~ [) view Point ~ T | “wselect ~
Lt I’\IZoom 7 Named View 4 'k Unselect ~
Redraw Initial Previous Hidden :
0 Check on Story View  View @ Pan ~ @ > @Select Previous ~
Then Select 2F IP Active All Ctrl+A
e

¥H Active Previous

@ Check on +Below

Active Identity X
= Ap———
® Click on Active O Current UCS Plane 1Q storvl
(") Named Plane () Group
(") Boundary Group () Load Group
(") Loading Area Group () Member
1F

IF
4F
SF
6F
7F
8F
9F
10F

(JFoar () +ﬁbue°:BEnT~| () +Both
d— L}

6Activated abject only
"Adive 1 Active + Inactive +

Active All Close
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Step

1[é} 6-2. Loading Data (Podium Floor Load )

Procedure Tree Menu === ==t SEEEE== Fe—fe—ree e —=5=(]

r
. MNod El t Boundary Mass 1 1
Apply Floor Load to the Activated e —— i '
R 1 1
F|00r [Ass:gn Floor Loads v] E] H -:
Load Group Name <_T______________________'___:_ i
Load Tab > Initial Forces/Misc (Default ) (o] r===-7
> Assign Floor Loads - L"a'o _______ |
ot or 0B} ) '

-‘<____.____.________.____

T—'i———-;———-"--____;___'___'

. Load angledal) 0 [dea]
0 Name: Podium Floor [ Exclude Inner Elem. of Area
[ Allow Polygon Type Unit Area v
Iy_tL__?Sf-b-{ir—— #d T e e e T T
@ Copy Floor load: 1@3 % A r 1
| b I I
(Total 1 floor and each | l | Ly 1 1
] . N Le
floor  distance is 3.0m) ¥ 2ner Gt . ot ket sl et el bl el el e ol
Unmodeled Sub-Beam
. No. of Sub Beams  : 0 <
To select the floor area, first b gt [0 -
Select Nodes Defining Loading Unit Self Weight: 0 knijm I
. . _— PODIUM FLOOR(Two)
. Load Direction & Projection Ay
Area where in You need to A )
Select the nodes . On the last T e

Description:

Click, the load is applied.

Modes Defining Loading Area:

'. |¥| Copy Floor Loadl Sﬁ L --40

.l'-\xis: Ox Oy @z L0

Distances: 1@3 m
{Example : 5, 3, 4.5, 3@5.0)
[T Convert to Beam Load Type |

cl
PODIUM FLOOR(Two)
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Step

I[¢M 6-2. Loading Data (Typical Floor Load)

P"ocedure Tree Menu
. Nod El t Boundary
Apply Floor Load to the Activated S sl
Floor [Assign Floor Loads v] E]
Load Group Name I —— Ep— g —_ N pE—
Load Tab > Initial Forces/Misc |Defaut g [ r HEE R
. ; I g ora I
> Assign Floor Loads Floar oz I B i
istribution: | Two way L 1 1 v 1 1
) Load snglelail 0 [deq] I I i I T
0 Name: Typ|Ca| Floor [ Exdude Inner Elem. of Area : : == : :
[T Allow Polygon Type Unit Area ! G =1 | ! ===l
| % %d
@ Copy Floor load: 14@3 g :\
(Total 15 floors and each l '
. . o 4 ’L Lx
floor distance is 3.0m) -+ 7l ]
Unmodeled Sub-Beam
Mo. of Sub Beams  : 0 3
To select the floor area, first P e
Select Nodes Defining Loading Untsdfweight: |0 | idijm
Load Direction & Projection
Area . On the last A
Click, the load is applied S s
Description:
Modes Defining Loading Area: TYPH FLi (Two)
SIDL {{8.0
LL:
T 7Y I Ui R
LEr——Tor @: 120 - 20
Distances: 14@3 m ST]]IZ;I_J 0 o
(Example : 5, 3,4.5,3@5.0) LL:-
[T Convert to Beam Load Type I
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Step

1[¢l 6-2. Loading Data (Roof Load)

Procedure

View Tab > Activities > All > Active

Identity

DebdEh =

Structure Node/Element Properties Boundary Load Analysis Results Pushover

=i B ¢ Dynamic ~ @View Point ~
./ ey -
L Zoom ~

Named View
Redraw Initial Previous
View View SJPan-~

'k Unselect ~
IE_] Select Previous ~

@ Check on Story
Then Select Roof

@ Check on +Above ¥# Active Previous

Active ldentity x

. . (") Current UCS Plane O story |
® Click on Active S ool
(_) Named Plane () Group

() Boundary Group () Load Group
() Loading Area Group () Member

BF
oF
10F _
11F J'_
12F
13F e i 5 H & =
14F
15F
16F
Roof

(") Floor !:°-+;b:ru'\e_'; +Below () +Both

[ gmactivated object only

) Adiive -II Adtive + Inactive +

Active All Close

e

)
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Step

1[¢l 6-2. Loading Data (Roof Load)

Procedure

Apply Floor Load to the Activated : = = = (R ; > = 1
Assign Fl ’ F===7==== fr=——— - I | ———— ————
Floor ssign Floor Loads I 1 : | 1 :
Load Group Name : : 1 I : 1
Load Tab > Initial Forces/Misc Default : b 1 :
. 1 1 1 1

> Assign Floor Loads Floor L“do ------- i i - e B & RS B " = =
Load Type: :Eoifﬂoir__;| 1 1 : | 1 |
Distribution: ~ Two way v : : 1 v : :

0 : - i) 5 : z! 54 : I¥] 5 # ! r
@ Name: Typical Floor DJedude I Elem. of Arv : i I :
[") Allow Polygon Type Unit Area 1 1 __. : 1
Wiy suadean EL] 1 1 1 1
1 1 | S— — 1 1
@ Uncheck Copy Floor load | < — ————— | ===

LS Ll L2 £ [ ¥ & 1

<

To select the floor area,

first Select Nodes

Defining Loading Area . Unmodeled Sub-Beam
No. of Sub Beams : 0 =
On the IaSt Sub-Beam Angle(A2): a0 o
Click, the load is applied UnitSef weicht: 0 kuim ! | : i ! ! i i i
Load Direction & Projection ] '
Load Diraction : Global Z v
Profection : (Oyes  ©No
Description: Rott Floor(lllivo)
NCIdE'j Deﬁlﬂn{l Loadnd hrea: L r .1'{ LJ\.li ;. 1\:1..'1L £ W LJ:I’ i )I e e 5 iy ’LJL-’JI- 1 1 L 1 WL L.l:l'
DL : -5.§ LTS )L.: 5.8
W e e e e e e i (L -14% PASE
]
W y z e B ) = i 48 o S|
14@3
[_] Convert to Beam Load Type —
Apply Close z W - i = + g 2 i
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Step

1[sl 6-3. Convert Model Weight & Loads to Masses

Procedure

Structure Tab > Structure type

BN{(l«J[(8 Node/Elem Properties Boundary Load Analysis Results Pushover Design Query Tools ﬂ Help v — & X

';' Check/Duplicate Elements
E Display Free Edge/Face ~
‘; Check Element Local Axis

p@ Structure
L BT ~
?J;] Change ~

I Dimension
.Ei Grids ~
Named Plane

Control
Data... ~

@ Structure type: 3-D
Mass Control Parameter:

Lumped Mass Structure Type *
Convert Self-Weight into Cructure Type
masses in 3-D : () %-Z Plane ()¥-Z Plane () %Y Plane () Constraint RZ
Convertto X,Y
. . Mass Control Paramet
Gravity Acceleration: o e
© Lumped Mass
9.806m/sec2 | Consider Off-diagonal Masses
Check beam section and "] Considering Rotational Rigid Body Mode for Modal Participation Factor
slab section Alignment () Consistent Mass
(X-Y Plane) 8 Convert Self-weight into Masses
() Convert to X, Y, Z 1 O Convertto X, v | () Convert to Z
Gravity Acceleration : 9.806 m/sec?
Initial Temperature : 0 [F]

B Align Top of Beam Section with Center Line (X-Y Plane) for Display
8 Align Top of Slab(Plate) Section with Center Line (X-Y Plane) for Display

0K ' Cancal
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Step

1[sl 6-3. Convert Model Weight & Loads to Masses

DenHOQ

Load Tab > Static Loads > View Structure Node/Element Properties Boundary Analysis Results Pushover De

@ Static Loads O Seismic O Settlement/Misc. _'I \"‘ Self Weight _:‘.- Nodal Body Force
Structure loads/Mass > LSRR LUeRRWE o LJSERERERERS L ) e | S T O s o onn

OTemp./Prestress O Construction Stage O Load Tables G/‘ Nodal Loads =\” Loads to Masses ~

41

= StaticLoad Using Load e o o e e e e
Loads to Masses () MovingLoad (7)) Heat of Hydration P e e o T

0 Mass Direction: X,Y Loads to Masses X
Load Case / Factor: Mass Direction
DL: 1 & 4 ?
] Ox Y Y, 2 X, Z ==
Click Add o 'ﬁ»"

. ok
SIDL 1 Load Type for Converting F%gl 7
. ot 4

Click Add 8 Nodal Load [ %
8 Beam Load <, FE
LL:0.25 @ Floor Load = g
Click Add B Pressure (Hydrostatic) ”,:",.?HD:
Gravity :  9.806 m/sec? rl?__ " g :
o Load Case / Factor ﬁ\fi,"' E
@ On clicking Ok Load Cose: DL " m Sk
Such a model is generated Scale Factor : ! F\i;.: ;
——————————— -
WioadC... Sc.. 1| Add &
I pL 1 1 T\
: L 035 :
I sioL 1 g| | Modify
1 1
e ———— ]
Delete

L OK i Cancel
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Step

1[sl 6-3. Convert Model Weight & Loads to Masses

Procedure

Query Tab > Mass Summary

View  Structure  Node/Element  Properties Boundary Load  Analysis Results  Pushover Design  Seismic Performance

* Y Node Detail Table ﬁ Story Weight Table E Element Weight Table a, Group Activation of CS
m Story Load Table Ig,., Mass Summary Tablel

,,, Story Mass Table m Load Summary Table

Table Praject

Status

..Eﬂ Element Detail Table

Query | Query

Nodes |Elements E Design Parameter Detail Table

Weight/Mass/Load Table Group Activation of CS
i TN KRB P E] S B E | |~ R EETEEEE] -
o Mass Summary can be 4 m Start Page Iﬁ MIDAS/Ger/@ Mass Summary X
viewed in X,Y & Z Direction. Node MNodal Mass| Load To |Structure Mass| Sum
» 1

2 0.0000 2.0396 30120| 50515

3 0.0000 2.0396 30120| 50515

4 0.0000 2.0396 3.0120| 50515

5 0.0000 40791 37860| 7.8661

6 0.0000 40791 37860| 7.8661

7 0.0000 40791 3.7860| 7.8661

8 0.0000 96879 6.0336| 157215

9 0.0000 96879 6.0336| 157215
10 0.0000 40791 3.7860| 7.8661
11 0.0000 40791 3.7860| 7.8661
12 0.0000 40791 3.7869| 7.8661
13 0.0000 40791 3.7869| 7.8661
14 0.0000 40791 3.7869| 7.8661
15 0.0000 40791 3.7869| 7.8661
16 0.0000 40791 37869| 78661
17 0.0000 40791 37869| 78661
18 0.0000 46230 48711| 94942
19 0.0000 40791 37869| 7.8661
20 0.0000 74342 4.8326| 12.2669
21 0.0000 40791 37860| 7.8661
22 0.0000 46230 48711| 94942
23 0.0000 40791 37860| 7.8661
24 0.0000 40791 37860| 7.8661
25 0.0000 40791 3.7860| 7.8661
26 0.0000 40791 3.7860| 7.8661

| o\ 27 0.0000 40791 3.7860| 7.8661 e
+ |*%\Nodal Mass(X) fNodal Mass(Y)/Nodal Mass(Z)/ |
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Step

1[i8 6-4. Wind Loads

Procedure o;‘\dd,«‘l‘ﬂocify Wind Load Specification X Wind Loads X
. | oad Case Name : WX > 1
1 A |
Load Tab > Static Loads : wind Load Code : [15875(2015) ~] Import | Load Case  Code Name Description | Add
. : 1 - 1 WX 15875(20... 1
> Wind Loads > Click [Add] } Dsstn : ) VORI .
: © standard Method (_) Gust Factor Method : I—————————————————I MDdIfY
1 i 1
0 Load Case Name : WX i H wind Load Parameters I —
. 1 Basic Wind Speed(Vb) : 47 m/sec 1 Sl
Wind Load Code : |8875(201 5) : Terrain Cateqory : il ~ :
Basic Wind Speed: 47m/s 1 —— : . |
" 1 Frictional Drag Coef.(Cf") : 1
1 : ’ 1
Terrain Category: I : Wind Directional Factor(kd) : 0.9 :
|| Combination Factor(kc) : 1 1 Close
. . . © Automatic Calculation (_) User Defined
Wlnd Load D|reCt|On FaCtor Class of Structure : General Buildings ~
. H i i 3 1
for X: 1 rest all will Risk Coeffcient(ic) R
i [ JInclude Topographic Effects
Be 0 CIICk Apply Topographic Factor(k3) : 1
Similarly assign the Load el ’ m Hind toad Profile x
[ Jindude Cydonic Region Effects Component Select Profile
paramete rs for WY Importance of Structure : Other Structures OxDir Ostory Force
(O Y-Dir © Story Shear
Importance Factor(k4) : 1
(OX&Y Dir (O overturning Moment
D Load Evaluation Using Force Coefficient ()5RSS
@ The loads are summarized in Force Coeffident(ch) : o TS Sy [
. T 28308631 7537306 [ 12108192
the d |alog bOX 12F 47508806 | 22368189 | 18816649
11F 46.71564 271.19079 | 2695.2373
) o 10F 45669838 | 317.90643 | 3648.9566
Wind Load Direction Factor (Scale Factor) oF 44377427 | 36357627 | 47396854
X-Dir. 1 Y-Dir. 0 7-Rot. 0 8F 43.103567 4079537 5963.5465
H H H 7F 41.601649 451.05726 | 7316.7183
0 CheCk Wlnd Ioad prOfIIe as If - . i 6F 30760426 | 49265891 | 8794695
Additional Wind Loads (Unit:kN,m) = 37 375958 53241934 10391953
Required Story [ Add-X | Add-Y [ Adc Add = e TR TR
\ \ | |
Cile Name:  E:\1. MIDAS INTERN\13. IS 875 -2002 and IS 1893 ——
. . . o 1_- = ™ Nake Wind Load Calc. Sheet I Browse Scoxy shear
@ For detail Calculation click on =y e ————
L_WEd_Liad_PEﬁ_le;_‘ oK Cancel Apply Close

Make wind load calc. sheet
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Step

06

6-5. Static Seismic Loads

Load Tab > Static loads
> Seismic Loads

@ Fill in the details as shown.
For EXP Click on Positive

@ Calculating time period, use
period Calculator for
Auto-calculation of periods
from the code equations

As per IS 1893:2016 for RC
Structures without brick infill panel

T=0.075h*(0.75)

@ Similarly defining all the load
Cases such a dialog box appears.

Procedure

Add/Modify Seismic Load Specification IS 1892:2016 Period Calculator X
____________ !
Load Case Name : Exp Z : X- Direction Period Y- Direction Period
Seismic Load Code : 1 151893(2016) 1 1. T = 0.075 h~{0.75) 1. T = 0.075 h~{D.75)
T o o o e - - -,
Description : ()2. T = 0.080 h~(0.75) ()2, T = 0.0B0 h™(0.75)
Seismic Load Parameters (3.7 = 0.085 h~(0.75) ()3. T = 0.085 h~{0.75)
Selsmic Zone (Z) : 111 {0.16) (714, T = 0.075 h~{0.75) [sqrt{Aw) (4. T = 0.075 h™(0.75) /sqri{Aw)
) e e e e e e e e e e —————— 1
Soll Type : I (Medium Sail) 105. 7= 0.09h / sart(d) Q5. T =009 h/ sqrt(d) |
(6. T = 0.0644 h~(0.9 V6. T = 0. A(D,
Importance Factor (1) : ’ ) /6. T =0.0644h(0.9)
5 (7.7 = 0.0672 h*(0.75) 7. T = 0.0672 h~(0.75)
Damping (%) :
. 1
Damping Multiplying Factor: hE 48 (m) h: 48 (m)
Aw: U {m2) Aw: U (m?)
. 52 o 32
Structural Parameters - (m) B (m)
X-Dir. Y-Dir.
Fundamental Period : 0.5001 0.7637 Note: Formula 6 and 7 in both the direction are applicable only if h>50
1 Period Caloulator... 1
_____________ OK Cancel
Re-slmnse Reduction Factor 50 50
(R):
Seismic Load Direction Factor (Scale Factor)
X-Direction : ! Y-Direction: 0
Accidental Eccentricity Static Seismic Loads X
X-Direction (Ex) : O Positive () Negative () None
Y-Direction (Ey) : “IPositive () Negative ) None OLoad Case  Code Name Description Add
) - EXp 151893-2... T
TEr.s.wnal Amplification B EXN 151893-2. . : Modify
|| Accidental Eccentricity |Inherent Eccentricity EYP 151893-2... 1
I_EYN 151893-2... 1
Additional Selsmic Loads (Unit:kNm) e —————————— - bl Delete
Story | Add-X Add-Y | Ade Add
Close
Seismic Load Profile... | oK Cancel
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Step

06

6-5. Static Seismic Loads

b

Buildings with RC structural walls:

0.0754"" 0.0
T = h h

where A is total effective area (m”) of walls in
the first storey of the building given by:

5[]

where

fi = height of building as defined in
7.6.2(a), inm;

A, = effective cross-sectional area of wall |
in first storey of building, in m?;

L., = lengthof structural wall f in first storey
in the considered direction of lateral
forces, inm;

d = base dimension of the building at the
plinth level along the considered
direction of earthqualke shaking, in m;
and

N_ = number of walls in the considered

direction of earthquake shaking.

The value of L /h to be used in this equation
shall not exceed 0.9,

In X Direction: (5 WALLS)
Shear wall (1): (4 X 3) =12 m?
Shear wall (2): (2 X 3) = 6 m?

Ay, =12 X [0.2 + (4/48) %]

Ay, = (2.48) X 2 =4.96 m?

Ay,=6 X [0.2 +(2/48) %]
Ay, =(1.21) X 3=3.63 m? }[ \
Ayr= Ay + Ay, = 8.59 m?

T.=0.075 X 48075 //8.59 = 0.4666
Ta(min) = 0.09 X 48 / /52 = 0.599

- 0.4666 £ 0.599 (Condition not satisfied)

In Y Direction: (2 WALLS)
Ayr = 4.96 m?

Ta=0.075 X 48075 /\/4.96 = 0.614
Ta(min) = 0.09 X 48 //32=0.7636

— 0.614 = 0.7636 (Condition not satisfied)

Since the empirical period (T,) is less
than the minimum value (T,(min)) in
both X and Y directions, the condition
is not satisfied. Hence, the period to be
used for analysis shall be taken as
T = 0.09h/Vd as per code
requirements.

www.MidasUser.com



http://www.MidasUser.com/

Step

1[:l 6-5 Static Seismic Loads (Seismic Profile)

Procedure Add/Modify Seismic Load Specification X Seismic Load Profile X |

Load Tab > Stath LoadS > L0ad Cosa it P Component Select Profile
0a dse Name : i -
. . [« B ) Story Force
> - . - 1803 . et e el -
Seismic Loads Seismic Load Code 151893(2016) - OY-DIr i) story Shear |
Select Load Case Name EXP > saription ot ) Ovetturing Mot
if Seismic Load Parameters (SRS
Modi y Selsmic Zone (Z) : I (0.16) Story Story Story Overturn'g | Ac:
. _ [ 15100601 | 35560632  |60622813 |08
Soil Type : 11 {Medium Soil) - oF 11630304 | 37079602 7174672 |08
™ - TF 85447132 | 38242722 | 83219537 08
. . . Importance Factor (1) : E ¥ BF 50338286 | 30007194 | 04948605 |08
@ Seismic Load Profile ) s [5F 37970503 | 39690577 | 10665567 08
Damping (%) : aF 21361783 | 40070342 | 11867697 08
3F 26353742 | 40283959 | 13006218 16
Damping Mulliplying Factor: - ec 58575438 _ | 40547407 | 14312641 _ 16
. It = 40016072 | 1hoa1123 | =1
@ X-Dir (on) T T 3
Story shear (on) Structural Parameters ouame- E:\L. MIDAS INTERN\13. IS 875 -2002 and IS 1893 e s
X-Dir. b | PO B <1 O —
conform Story Shear of Base L EEms T ) o
floor '

Period Caloulator...

%Eanse Reduction Factor 50 -1 5.0

@ Conform the Story Shear

Seismic Load Direction Factor (Scale Factor)

X-Direction : 1 Y-Direction : 0
@ For detail Earthquake load Accidental Eccentricity
Calculation click on Make seismic *Owetion (B): ~ QPoskive  ONegative () Nome
Y-Direction (Ey) : ") Positive () Negative ) None

Load Calc. sheet Torsional Amplification

[ ) Accidental Eccentricity " | Inherent Eccentricity

Additional Seismic Loads (Unit:kN,m})
Story | Add-X Add-Y | Ade Add

|

| SeismicloadProfile.. 1| OK | Cancel
H
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Step

06

Procedure

Load Tab > Dynamic Loads >
Response Spectrum Data >

Response Spectrum Function

@ Add > Function Name: Design
Spectrum

@ Generate Design Spectrum:
Design Spectrum:1S1893(2016)
Seismic Zone: llI

Soil Type: Il Importance Factor: 1
Response Reduction Factor: 5

Click OK

Such a Dialog Box appears.

Click OK

The Response Spectrum function
is generated

Add/Modify/Show Response Spectrum Functions

Function Name

151893(201 4 O Normalized Accel. () Acceleration () Velocity ) Displacement
_______ Scaling Gravity Graph Options
Import File ' Design Spectrum || ° Scale Fador 1 9.806  mjsec2 [)x-ads log scale
Peried | Spectral ) Damping Ratio _ )
— Mate () Maximum Value a 0.05 | ¥-axis log scale
1| 0.0000 0.0192 |
| =21 00600/ 00365 0. 0854584
3| 01000  0.0480 s ossssan
4 0.1200 0.0480
5| 0.1800 0.0480
6| 0.2400 0.0480
7| 0.3000 0.0480
8| 0.3800 0.0480
0.0244544
| o] o4200 00480
10| 0.4800 0.0480 b 0-018d84d
11| 0.5400 0.0480 0.0144544
12| 05500 00480
13| 0.6000 0.0435
14 0.6800 0.03%6 “mw::‘rlo.lrlnl 2 e 201 241 2ot S2L S6 401 44n 46 s s eon
| 15| o.7200 0.0363 Perioa (ses)
Description  151893(2016): Zone=111{0.16), Soil= 1{Medium), Damping= 5.00, 1=1.20, R=5.00
-l oK Cancel
Add/Modify/Show Response Spectrum Functions
Function Name Spectral Data Type
151893(2016) O Normalized Accel. () Acceleration () Velocity _) Displacement
Scaling Gravity Graph Options
Import Flle | Design Spectrum © Scale Factor 1 9.806  m/sec (Jxants fog scale
Period | Spectral W, Damping Ratio . )
Sy Maia () Maximum Value a 0.05 | Y-axis log scale
1| 0.0000 0.0192
2l 0os00  oo3ss
3| 0.1000 0.0480
4| 01200 0.0480 s
5| 0.1800 0.0480 s
6| 0.2400 0.0480 44544
7| 03000  0.0480 peass
8| 0.3600 0.0480
9| 0.4200  0.0480 e
10| 0.4800 0.0480 i 0-014sd
11| 0.5400 0.0480 0.0148544 -
12| 05500 o0.0480
13| 0.6000 0.0435
14{ 0.6600 0.0336 4‘wﬂ:‘r‘o.‘rlnl P L L
| 15| 0.7200 0.0363 | Perioa (sec)
Description  [51893(2016): Zone=I11{0.16), Soil= 11{Medium), Damping= 5.00, 1=1.20, R=5.00

Spectral Data Type

6-6. Response Spectrum Functions

Generate Design Spectrum bt
Dresign Spectrum : 6.151893(2016] : d
T T T T T T T [
Seismic Zone
(I (0.10) O 11 (0.16)
(v (0.24) (v (0.36)
Soil Type

T (Rock or Hard Soil)

© 11 (Medium Soil) ()11 (Soft Sail)
Damping(%) : 3
Damping Multiplying Factor : 1
Importance Factor (1) : 1.2
Response Redudction Factor (R) : 5.0
Max. Period : 6 (Sec)
0K | Cancel

A

ot J  Cancel
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Step

I[N 6-7. Response Spectrum Load cases

Procedure

Load Tab > Seismic > Response

Spectrum Data > Response

Spectrum Load Cases

€ Load Cases Name : SpecX
Excitation Angle : 0

@ Check : IS 1893(2016)
@® Click [Add]

@ Load Cases Name : SpecY
Excitation Angle : 90

@ Click [Add]
The two Spectrum Load Cases

Are created

Click Eigen Value Analysis
Contol

] Response Spectrum Load Cases "

Spectrum Load Case

7 0Load Case Name:  SpecX 1
1
'Elrecncn : XY a1
[] Auto-Search Angle
(@) Major Ortho

Excitation Angle: 7 = [deg]
Scale Factor : 1
Period Modification Factor :

1

Modal Combination Control E]
e Spectrum Functions
————————————
= Function Name {Damping Ratio) 1

L[ TI51893(2016) (0.05 :

[~ Apply Damping Method

Damping Method...

Correction by Damping Ratio
Interpolation of Spectral Data

() Linear (@ Logarithm

[ Accidental Eccentricity

Description :
LoadCase Direction Scali
SpecX XY 1

] 1 ] »

[
\perations
¥ !

[ Eigenvalue Analysis Control... ]

[ Response Spectrum Functions... ]

Close

Tree Menu

m

] Response Spectrum Load Cases "

Spectrum Load Case

Direction Xy w7
[ auto-Search Angle
(@) Major Ortho
Excitation Angle : 90 = [deq]
Scale Factor : 1
Period Modification Factor
1

Modal Combination Control E]

Spectrum Functions
Function Name (Damping Ratio)

[ - [151893(2016) (0.05

[ Apply Damping Method

Damping Method...

Correction by Damping Ratio
Interpolation of Spectral Data

() Linear (@ Logarithm

[T Acridental Eccentricity

Description :

LoadCase Direction Scalg
Speck XY 1
SpecY Ay 1

< M ]

perations
!Lnddl Modify | |Delete

[ Eigenvalue Analysis Contral... ]

[ Response Spectrum Functions... ]

Close

Tree Menu

m

* Auto-Search Angle (Principal Axis)
Select this option to automatically take the
excitation angle of response spectrum as the
major-axis direction of a building.

"Major" and "Ortho" must be defined in the
identical Response Spectrum function.

For example, if we define "RX" load case as
"Major”, "RY" load case must be defined as
"Ortho". After performing the Response Spectrum
Analysis, excitation angle of the structure will be
automatically entered in the "Excitation Angle"
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Step

06

6.8. Eigen Analysis Control

Eigenvalue Analysis Control

Type of Analysis
© Eigen Vectors
() Subspace Tteration
O Lanczos

Analysis Tab> Eigen value Analysis
Control

€ Number of Frequencies : 20
Then click OK

@ Analysis Tab > perform analysis

[ I Frequency range of interest
Search From : 0 [eps]
To: 0 eps)

Remove Eigenvalue Analysis Data

Node/Element

Control Data

Properties

Hydration Load
Analysis Control

() Ritz Vectors

[ sturm Sequence Check

Ok | Cancel

Boundary Load Pushover Design Query Tools

Analysie Results
2

E][ Analysis Options

Batch Analysis
Perform
Analysis I‘E_% Import Analysis Result

Perform

2

P-Delta Buckling Eigenvalue Heat of Moving Nonlinear Construction Boundary Change

Stage Assignment
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Step

07 &} Analysis of Results

Procedure

Results Tab > Tables > Result
Tables > Story > Story Shear
(Response Spectrum Analysis)

Spectrum Load Cases >Spec X(RS)

(on) & Spec Y(RS) (on)

@ Compare RX(RY) with EX(EY)

o Inertia Force Shear Force
X-Direction Scale Up Factor
16F | 45000 Spec X( | 1.4647e+|0.0000e+ 0.0000e+ 0.0000e+| 35463e+|0.0000e+ 3 5463e+ 0.0000e+ . L . .
15F | 42.000 Spu:ﬁ 1 99190+ 000006+ 0 0000e 000006+ 4 8754es 00000s 4 875de D00es = Static seismic result / Dynamic analysis
14F | 39.000/Spec X( |14524e+|0.0000e+ 0.0000e+ 0.0000e+|57953e+ 0.0000e+ |5 7953e+|0.0000e+ FesSult
13F | 36.000|Spec X( |1.4672e+|0.0000e+|0.0000e+ 00000+ |6 5292¢+|0.0000e+ | 65202€+ 000008+  _ oy o /1257 5
12F | 33.000|Spec X( | 1.4536e+|0.0000e+ 0.0000e+ 0.0000e+|7.1753e+|0.0000e+|7.1753e+|0.0000e+ . :
11F [ 30.000|Spec X( |14796e+ 0.0000e+ 0.0000e+|0.0000e+ |7 7524e+|0.0000e+ 7.7524e+|0.0000e+  _5 g9
10F | 27.000(Spec X( |1.5369+|0.0000e+ 0.0000e+ 0.0000e+|8.2723e+|0.0000e+ 8 2723e+ | 0.0000e+ ’
oF 24.000 |Spec X{ | 1.5632e+|0.0000e+ 0.0000e+ 0.0000e+|8.7709e+|0.0000e+ 8.7709e+ 0.0000e+
BF 21.000|Spec X(_|1.5820e+|0.0000e+ 0.0000e+ 0.0000e+|0.2732e+|0.0000e+ 9.2732e+ 0.0000e+ Y-Direction Scale Up Factor
F 18,000 |Spec X( | 1.5810e+|0.0000e+|0.0000e+ 0.0000e+ 9.7851e+|0.0000e+ 078510+ | 0.0000e+
6F 15.000|Spec X( | 1.5450e+|0.0000e+ 0.0000e+ 0.0000e+|1.0305e+|0.0000e+|1.0305¢+ 0.0000es = 3786.27/1431.1
E3 12,000 |Spec X{ |1.4793e+|0.0000e+ 0.0000e+ 0.0000e+ 1.0816e+|0.0000e+ 1.0816e+|0.0000e+ =222
4F 9.0000 Spec X{ | 1.3596e+ 0.0000e+ 0.0000e+ 0.0000e+|1.1286e+ 0.0000e+ 1.1286e+|0.0000e+ ~<-
3F 6.0000|Spec X( | 3.3461e+ 0.0000e+ 0.0000e+ 0.0000e+ 1.1679e+ 0.0000e+ 1.167%+ 0.0000e+
2F 3.0000 |Spec X{ |1.9850e+|0.0000e+ 0.0000e+ 0.0000e+ 1.2742e+|0.0000e+ 12742e+|0.0000e+
1F 0.0000 |Spec X{ | 1.3575e+ | 0.0000e+ 0.0000e+ 0.0000e+|1.3575e+|0.0000e¢ T 3575+ ¥.0000e+
Roof | 48.000 |Spec Y(R 0.0000e+ | 3.7458e+ 0.0000e+ 0.0000e+|0.0000e+ | 0.0000e+ OTIOCE+ | 0.0000e+
16F | 45000 Spec Y(R|0.0000e+|1 5702+ 0.0000e+ 0.0000e+| 0.0000e+ |3 7458+ 0.0000e+ |3 7458e+
15F | 42,000 Spec Y(R|0.0000e+|1.5295¢+ 0.0000e+ 0.0000e+| 0.0000e+|5.1537e+ 0.0000e+ | 5.153Te+
Seismic Load Profile x* | Seismic Load Profile X
Colpeﬂﬂ_ p— ﬂeﬁ_p“ﬂ’_ - Component Select Profile
IrQX-Dir OsoryFore () Story Force
el SN T T
i () Overturning Moment () Overturning Moment
Story Story [Ovartimy g | Story Story Story Overturn'g | Act
6505+ | nuroess {79767 08 I e N R
15 SS4ATIS2 36242722 83219537 |08 i3 67030741 | 30000261 | 65283259 18
S ot satsr7—| sassaaT— o8 B |dosios |serosey  rassass 18
aF 21361783 | 40070342 | 11887697 |08 oF 20791441 |3113608 83826250 |18
3F 26353742 | 40283950 | 13096218 18 e 1 775700 4 Y3005 M B2 45 M [ 118
e P 00 B 2 12 O T = T0Zi0s Ty iziE0s | -
File Name: E:\1. MIDAS INTERN\13. IS 875 -2002 and IS 1893 Wsm“ o Seary Shear
File Name: E:\L MIDAS INTERN\13. IS 875 -2002 and IS 1893
M; ismi Il e =
e SemicLoad (e Shest o @) coe ] Make Selsmic Load Calc. Sheet Browse =
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Step

[¢ T

Results Tab > Combination >
Load Combination > Concrete

Design

@ Select Concrete Design tab
@ Click Auto-Generation

© Select Design Code
as “1S456:2000 ”

@ Scale Up of Response Spectrum
Load Cases

Scale Up Factor: Spec X 2.99
Click Add

Scale Up Factor: Spec 'Y 2.22
Click Add and Click [OK]

% J| 7 Reactions - Y1~

Il || Deformations ~ {7}~
Load

ZE} Beam/Element ~

{#- Local Direction..

_; Plate Local Axis

1Y@ 7-1. Automatic generation of load combinations

C F. 1 Forces ~ S ; 1 Displacement Participation Factor
Load Combination \ o =] =]
——
General | steel Design ! Concrete Design I SRC Design | Footing Design |
~Load Combination Lis ~Load Cases and Factors ———————————
| No | Name [ Active | Type | Descripti B | LoadCase | Factor
| I I I \
< e ] v =
AT
Copy Import. ! Auto Generation. ! Spread Sheet Form
FieName: [ Crisersmidas\Docmentslsesmic analysisIcp Browse | MakeLoad Combiatin heet | | Close:

Results
_L Mode Shap
F’"" Modal Dam

| -* Nodal Resu

Automatic Generation of Load Combinations

Option
O add ) Replace
Code Selection
Steel © Concrete SR
Cold Formed Footing
Aluminum
[
Design Code : 15456:2000 1

B Scale Up of Respanse Spectrum Load Cases

oca\e Up Fadtor : 2.22 Spec ¥
e
“Factor Load C... 1 Add
2.990 Spec X 1
I 2220 specy 1 Modkty
1 1 Delete

Manipulation of Construction Stage Load Case

ST Only CS Only ST+CS

[ ] Consider Orthogonal Effect

SRSS{Square-Root-of-Sum-of-Squares)

Generate Additional Load Combinations

ic Load

Will Execute Construction Stage Analysis

Conslder Losses for Prestress Load Cases

OK Cancel
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Step
8-1.Verification of Reactions

Results Tab > Results > Reaction

forces (or) moments

@ Load cases/combinations
CBC:cLCB 1

@ Click on this to see Results in
tabular format as shown below.

Procedure

Tree Menu

GUETad LBl Deformati... Forces Stresses

[R.eactian Forces/Moments v] G

A4
1

1
Heae: acel - 1]
3
Step
Components
©FX ©F ©FZ @FXYZ
My My MZ D) MXYZ
Mb

[T Local {if defined)

Type of Display

[ values [ [[(iegend [

Arrow Scale Factor: 1.000000

o x

SUMMATION OF REACTION FORCES PRINTOUT

| oad FX FY FZ
Ly (e { kel
DL 0.000000| 0.000000|23212.5088
LL 0.000000| 0.000000|27448.0000
SIDL 0.000000| 0.000000|34080.0000
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Step

1}:8 8-2.Displacement contour

Procedure

Results Tab > Results

Deformations>Displacement contour

€ Load cases/combinations

CBC:cLCB1

@ If For Animation, click on

Animate and Apply

Tree Menu 3 x

Reactions EMS{lduEi(®8 Forces Stresses

(@) Displacement Velodty
Acceleration
Absolute Acceleration

Components
(@)1 (@] ®oz
@ Rx @Ry [@]:F:
R
() oy ovz © DXz
@ Dxvz

Local (if defined)
Type of Display

Contour [,:] Deform E]
values [ Legend  [od
=T L_:H_FE?EJ [ Undeformed
Mirrored [
Plate Cutting Diagram [
[] current Step Displ.

NN

L/

. W

AYAYa s AYAYAYAYA

a

F

i
v

AV
AVA
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Step

1]:8 8-3.Bending Moment Diagram

Procedure Tree Menu

Reactions Deformati...

View Structure Node/Element Properties Boundary Load Analysis Results

Results Tab > Results > Forces > Per— ']E] % “-Reactions - g~ | TQ Beam/Element - 124 Piate Local Axis
Beam Diagrams = e _ﬁ_DeLonn_a(.i:ns - ¥4 | ¥+ Local Direction..
Load Cases/Combinations Combination | L Forces - § &3 | Tt isplacement Participation Factor
; icsc: d.CBL v!E]
Step

@ Load cases/combinations
Max,/Min Diagram

CBC:cLCB1
. Compeonents
@ For Values, click on Values oot |
and Apply ® ® m | _ ﬁ" el
©Fz =) Fyz —— '—‘
Mz () Myz 1 -— .-
Mt Mw —
Show Truss Forces ‘ — -
Only Truss Forces ——
Display Options ‘ > .
© Bact 1
@ 5Points ol —
Scale: 1000000 | Solid il 1 I
| vjr

Type of Display
[V|Contour [ [CIDeform [LJ
‘I_:|\|'alues _! [ [CJLegend [

[T animate [ [C]Undeformed
[[IMirrored [ QuickView [LJ]

Output Section Location — ——
I Center ]
Abs Max Min/Max All
By Member
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Step
8-4.Vibration Mode Shape

Procedure

Results Tab > Tables > Results
Tables > Vibration Mode Shape

@ Select Mode 1
You can Select any mode

shape from dropdown box

@ Click on Apply

Mode Shapes

['l.ﬁbration Mode Shapes v] E]

Load Cases{Made Mumbers)

iMcde 1 v_l

[ Multitodes ]
Components

OmMdx COMdY (O MdZ
DMdxy (O MdY¥Z () MdxzZ
(@ Md-XYZ

Type of Display

Md.Shp.  [a  []Undeformed
[ values [ [[Legend [.J
|:| Animate IZ] |:| Contour IZ]

2

A

|

— — -

Tree Menu
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Step

1};8 8-5.Modal Participation Masses

Procedure m Node | Mode U uy uz
Mode Shapes

Results Tab > Mode Shapes > J— MODAL PA
Vibration Mode Shapes | vbraton Mode Shapes 'i_[;]la Mode|  TRAN-X TRAN-Y TRAN-Z
Load Cases{Mode Numbers) No [MASS([SUM(%)| MASS({[SUM(%)| MASS( [SUM(%)
o i o - [Mode 1 - 1| 60.1541] 60.1541| 0.0000( 0.0000| 0.0000| 0.0000
fﬂ'é%keg‘h;hpee”ghts'de of Vibration [ = ] 2| 0.0000]60.1541|60.8814|60.8814| 0.0000] 0.0000
S 3| 0.8464|61.0005| 0.0000(60.8814| 0.0000] 0.0000
0 somarmcoinns T s soufoa sxm 1o
OMdXY  OMdY¥Z (O MdXZ - - - - - -
In Mode 11, both x & y direction © mexvz 6| 0.6615|73.9592| 0.0000(73.7311| 0.0000] 0.0000
| 7| 8.7704]82.7296| 0.0000(73.7311| 0.0000] 0.0000
Type of Display
Md.Shp. () [FlUndeformed 8| 0.0000]82.7296| 8.4740(82.2051| 0.0000] 0.0000
Flvaes & Fllegend (& 9| 0.9311]83.6607| 0.0000(82.2051| 0.0000| 0.0000
Flanmate & Flcontor (& 10| 7.7846(91.4453| 0.0000(82.2051| 0.0000| 0.0000
&P 7] 0.0000[i91 4453} 7.9015430.1066] 0.0000| 0.0000
12| 0.6073]92.0526] 0.0000|90.1066| 0.0000| 0.0000

13| 3.8070|95.8596| 0.0000/90.1066| 0.0000( 0.0000
14| 0.0000|95.8596| 4.4644 945710 0.0000( 0.0000
15| 0.2765|96.1360 0.0000|94.5710| 0.0000( 0.0000
16| 1.1866|97.3227| 0.0000|94.5710| 0.0000( 0.0000
17| 0.0000|97.3227| 1.8292|96.4002| 0.0000( 0.0000
18| 0.8000|98.1227| 0.0000|96.4002| 0.0000( 0.0000
19| 0.0159|98.1386| 0.0000|96.4002| 0.0000( 0.0000
20| 0.0000|98.1386| 1.0547|97.4550| 0.0000| 0.0000

Tree Menu
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Step

1N 9.1 Story Drift

e

dary Load Analysis [ESV Pushover

Tools

Design Seismic Performance  Query

Results Tab > Results Table > JQ Beam/Element ~ 4" Mode Shapes ~ 4. Influ. Lines ~ TH Results ~ B ; ™% Unknown Load Factor
Story > CheCk Parameter b Local Direction.. u Modal Damping Ratio.. fﬂtr Influ. Surfaces - T.H Graph/Text ~ Columir; Shié)lrtening Stojr;Sjr:ear # Tendon Loss Graph ol

: 1 Displacement Participation Factor | % Nodal Results of RS m Moving Tracer ~ | k. Stage/Step Graph Graph for CS  Force Ratio Tables _|

i Select Code X A5 Records Activation Dialog X : X1 Check Parameter. TRETU'tS
- e e s e sl dDES
@ Select Country Code : I == ! w4 story Drit. L Reaction
1 Country Code : 151893(2016) 1 ]  Loadcase/Combination 1 'ﬂ--------------- =
1 1 1 BLET 1 = " Displacements
IS1 893(201 6) and 1 1 1 (DD 1 g Story Displacement... TGS »
1 1 1 (IsIDL(ST) 1 g Story Shear (Response Spectrum Analysis).
i Cancel (CJwx(sT) Cable »
click ok : : : CJwy(sT) : 3 Story Shear (Time History Analysis)... — N
e 535@% 1 3 story Mode shape... Plate »
: %EYP(ST) : 8 story Eccentricity... Plane Stress 4
NTC2018 EYN(ST) .
Results > Results Table > INTC012 1 | sy I | RESEE Plane sran 8
. NTC2008 1 1 [ JspecY(rs) 1 {3 stability Coefficient... Axisymmetric )y
> 1 1 Y
Story Story Drlft 1 E%[fz{%?gg 1 : ! g Irregularity Check Parameter... Solid >
: NTC52020 1 1 3 Weight Iregularity Check... Wwall >
1 : ¥ overturning Morment... B2 Elastic Link
. . L e - C_anc_el_ g Story Axial Force Sum... B4 General Link
9 SeleCt the Load Comblnatlon g Torsional Irregularity Check... 4 vibration Mode Shape
Type and CIiCk Ok ¥ Torsional Amplification Factor... Mode Shapes Iregularity Check
_'_ Buckling Mode Shape
Load Stary | P-DF)Itiat Allowable Maximum Dril;\ldgfdé}l:e\é'e rtical Elements M[())gﬂr:tdthe C[n;)r)ltier of Mass "_Nodal Results of RS __ _ _ _
oa : ncrementa - - ifi - - ifi ri y
Case Stary H(e[lﬁ;)ht | Factar Skl)qr};llii:)nﬂ Node Sto(r:;?nﬁ Drift Skér;lliitl)nﬂ Py Stog]l)]nﬂ Drift Factor St(églli?)nﬂ Frerey L _St:ry_ 2
fad) (m) (m) (Maximu Inelastic Hinge >
RMC Not Used, Cd=1, le=15, Scale Factor=1, Allowable Ratio=0015 T (e Avelysis »
Press right mouse button and click 'Set Story Drift Parameters...' menu to change RMC or Cdl/le/Scale Factor/Allowable Ratio/Betal
Heat of Hydration Analysis >
Tendon 4
Composite Section For C.5. >
Displacement Participation Factor P
Initial Element Force
H imperfection
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Step

1[*N 9.2 Weight Irregularity Check

e

dary Load Analysis QBRESVIcE Pushover  Design Seismic Performance  Query  Tools

ReSU|tS Tab > ReSUItS Table > IQ Beam/Element ~ _L Mode Shapes ~ Influ. Lines ~ T.H Results ~ e "I" Unknown Load Factor

1 » Local Direction.. Modal Damping Ratio.. ::—'—2- Influ. Surfaces ~ T.H Graph/Text - = Tendon Loss Graph
Story > Irregl'”arlty CheCk ; J i ) g Column Shortening Story Shear - Text Results
Parameter i 1 Displacement Participation Factor | | * Modal Results of RS ﬁ Moving Tracer ¥ | k. Stage/Step Graph Graph for CS  Force Ratio Output [ Tables |

I Select Calculation Method X1 S ——— x 1 g Check Parameter... Results
. - ecords Activation Dialog 1 |Tables
o SeIeCt COU ntry COde ) I CountryCode:  151893(2016) 1 | B sty piift.. <8 Reaction
] § ] | Loadcase/Combination W= .
Story Drift Method 1 F . Displacements
1S1 893(201 6) and : © Drift at the Center of Mass 1 : DL(ST) : 3 story Displacement... T N
CIle Ok 1 Max. Drift of Outer Extreme Points : 1 :]_t,;ési(ré-r) 1 ﬁ Story Shear (Response Spectrum Analysis)... Cable >
: Max. Drift of All Vertical Elements ] 1 %m((gp) 1 ﬁ Story Shear (Time History Analysis)... Beam >
1 1 1
I Story Stiffness Method ‘ 1 Beecn 1 £ story Mode shape... Plate »
1 1/ Story Drift Ratio : 151803(2016) v 1 %gﬁg’% | B3 story Eccentricity... Plane Stress »
1 or ear [ Story Dril NTC2018 ol ear Force Ratio. i
Resu ItS > ReSUItS Table > I o - ! ISQ " " : :m¥ggé§ : §§:ENC(§{'){S) : g zal?illii:Cueiﬁ(ienT . o ’
. . 1 cancel || 1 Spec Y(RS) ] Asisymmetric >
Story > Weight Irregularity Check  « oo oo o coca o S50 S oo i A2 v oo oo ,
::Eg%g%g : ‘: 155 weight irregularity Check.. v »
f%&— 1 1 BT Gverurming Momento |2 Elastic Link
. . 1516700(2023) 1 ok | I 8 story Axial Force Sum.. 81 General Link
9 SeleCt the Load Com blnatlon E== - - EHEI- - ﬂ Torsional Iregularity Check... 4 Vibration Mode Shape
Type and click ok £ Torsional Amplification Factor... Mode Shapes Iregularity Check
| =1 i Buckling Mode Shape
Stol : 1.5"Lower | Stol <
Load SIOW Level Hei n;lt StOW We'Qm Sto Wei n;lt Remark ﬁ Stiffness Irregularity Check(Soft Story)... '._N_ediR&sul_tso_ﬂE o
Case (m) 9 (kN) v g
{m Weiaht Ratio B Capacity Iregularity Check (Weak Story).. Story
» |EXP  |Roof 48.00 000, 8219281 6828415 0000 Regular Tinelastic Hinge ¥
EXP |16F 45.00 3.00| 4552277 6828415 0667 Regular Time History Analysis 4
EXP |15F 42.00 3.00| 4552277 6828.415| 0667 Regular Heat of Hydration Analysis »
EXP |14F 39.00 3.00| 4552.277| 6828415 0.667 Regular fencay g
EXP  |13F 36.00] 3.00| 4552.277| 6828415 0667 Regular Composite Section For C.5. >
EXP  [12F 3300] 300 4552.277| 6828.415) 0667 Regular J oiwicement ericpation fcter ’
6 THE | 3000 300 4582277 6620475 0667 Reouiar ;;
L. i Imperfection
EXP |10F 27.00 3.00| 4552277| 6828415 0667 Regular o ?

EXP |9F 24.00 3.00] 4552277| 6828.415| 0667 Regular
EXP |8F 21.00 3.00] 4552277| 6828.415| 0667 Regular
EXP |7TF 18.00 300| 4552277 6828415 0667 Regular
EXP |6F 15.00 3.00] 4552277| 6828.415| 0667 Regular
EXP |5F 12.00 3.00] 4552277| 6828.415| 0667 Regular
EXP |4F 9.00 3.00| 4552277|18954.277| 0240 Regular
EXP |3F 6.00 3.00| 12636.185|197286.475| 0641 Regular
EXP |2F 3.00 3.00| 13152.317 0.000| 0.000 Regular
EXP |1F 0.00 3.00 967.128 0.000| 0.000 Regular
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Step

09

Results Tab > Results Table >
Story > Irregularity Check
Parameter

9.3 Stiffness Irregularity Check

Results SEVEIES

dary Load  Analysis Design Seismic Performance  Query  Tools

14 ] “I"Z Unknown Load Factor

=~

Column Shortening Story Shear
Graph for CS  Force Ratio

;L- Mode Shapes ~ T.H Results ~
u Modal Damping Ratio..

| % Nodal Results of RS

IQ Beam/Element ~

Influ. Lines ~

fﬂtr Influ. Surfaces -

: _ 11
i Local Direction.. L

T.H Graph/Text ~ Tendon Loss Graph
Results

Tobles _|

: 1 Displacement Participation Factor m Moving Tracer ~ | k. Stage/Step Graph

Results

@ Results > Results Table >Story 1= Records Actvation Dislog X g check Pt ables
. . 1 Story Drift... = peaction
> StlffneSS IrreQUIarlty CheCk 1 ‘Loadcase/cambination fﬂ "ﬂ Displacements
1 DL(ST) g Story Displacement... Thss »
: %EEI(DSLET) g Story Shear (Response Spectrum Analysis)... Cable »
. . 1 OJwx(sn) {3 Story Shear (Time History Analysis)... - »
@ Select the Load Combination | @boisn 3 story ode Shape.. pate »
Type and click ok 1 Cowen B st eccenticy pane strss >
: %EYN(S‘(F) , g Story Shear Force Ratio... Plane Strain 'S
5pec X(RS) ﬂ Stability Coefficient... N i
1 OspecY(rs) Axisymmetric >
1 g Irregularity Check Parameter... Solid >
1 8 weight Iregularity Check... Wall >
: g Qverturning Moment... ig Elastic Link
1 g Story Axial Force Sum... B4 General Link
oK Cancel
bm— _ - -anE - g Torsional Iregularity Check... 4 Vibration Mode Shape
g Torsional Amplification Factor... Mode Shapes Irreqularity Check
Story - Story Story | Upper Story i i de sh
Load Level : Story Drift ’ - e o e o e e e ] - BUCKIING Mo Shape
Case S (m) Height {m) Shear | Stiffness S_IOW Stlﬂngss Hemalk 1E81 stiffness Irregularity Check(Soft Story)... _Nodal Results of RS _
y "H'c?pa?ty-me-gmrﬁ Check (Weak Story). Story
EXP [15F 4200]  300] 00027 163113 601253 |440747.| 1.364|Regular DEmIEngR >
EXP |14F 3900/ 300 00030 209634 708811 601253 1.176|Regular Time ”f‘;y FUElEE . :
EXP [13F 36.00) 3.00 00032 249747 774356.| 706811.| 1.096|Regular :e‘"’; e .
EXP |12F 3300/ 300 00035 283926 818766.) 774356.| 1.057|Regular e
Composite Section For C.5. >
EXP |11F 3000 300 00037 312645 850196 | 818766 1.038|Regular : N
Displacement Participation Factor P
EXP |10F 27.00 300 00038 336381 875516.| 850196. 1.030|Regular 8 1nitial lement Force
EXP |9F 24.00 300 00040 3556.06 899812 | 875516. 1.028 |Regular G.L. ; I
EXP |8F 21.00 300 00040 3707.97 927627.| 899812 1.031|Regular oo
EXP |TF 18.00 300 00040 382427 964200 | 927627. 1.039|Regular
EXP |6F 15.00 300 00038 3909.72 1017290  964209. 1.055|Regular
EXP |5F 12.00 300 00036 3969.06 1100876(1017290, 1.082|Regular
EXP |4F 9.00 300 00032 4007.03 1245620(1100876, 1.131|Regular
EXP |3F 600 300 00026/ 402840 1549300(1245620) 1244 |Regular
EXP |2F 300 300 00015 405475 2758028|1549300, 1780 |Regular
EXP |1F 0.00 300 00008 406161 5324219|2758028  1.930|Regular
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Step
9.4 Story Shear Force Ratio

Procedure

View Tab > Activities > All > Active
Identity

Oemdald s

View Structure Node/Element Properties Boundary Load

B @ 3
J

a I zoom ~ <@
Redraw Initial Previous Hidden

View View SJPan-~ & -

Analysis Results Pushover

& Select ~ o | —
= 1
'k Unselect ~ 1 1
Active Inactivel All IInverse
IE] Select Previous ~ I o 1 adtive
Ip Active All Ctrl+A
1

(&) view Point ~
Named View

@) Check on Story
Then Select Roof

@ Check on + Below

Active Identity X
@ Click on Acti () Current UCS Plane ol_o:si_aij
ICK On Active (") Named Plane () Group
(") Boundary Group () Load Group
(") Loading Area Group () Member
8F
9F
10F
11F
12F
13F
14F
15F
16F

[ gm\ctivated object only

9! Active : Active + Inactive +

Active All Close
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Step

1[*N 9.4 Story Shear Force Ratio

Procedure
erties  Boundary Load  Analysis

Results Tab > Story Shear Force 4 Strain - | JQ Beam/Element ~
RatIO 3¢- Local Direction..

;t Mode Shapes ~
_] Modal Damping Ratio..
[ -* Nodal Results of RS

4. 1nflu. Lines ~ TH Results - b I 171 Unknown Load Factor

‘.. T.H Graph/Text ~

5| @

Text Results
Qutput | Tables

‘-H Influ. Surfaces -

. . 7+ Tendon Loss Graph
Column Shortenind] Story ShearI
Graph for CS | Force Rati

ﬁ Displacement Participation Factor m Moving Tracer ¥ | k. Stage/Step Graph

1D ¥ S B 2 B | " VLY BRI EEm | e N )
(1) Select the Load Case : EXP midas Gen

POST-PROCESSOR
Story Shear Force Ratio STORY SHERR RATID

4.945818=-02

@® Check on Ratio and Legends

and Clle Apply osturyshearFurceRatiu vl ! ;zzzizz;zj
i TD;-::EEE;?ES----------?-- --4:18696&-02
R e | \2J I e
: Direction of Shear T -1.63685=-01
I Angle [deq] — :1 94139:31
: Type of Display % \ -j.iizie-;i
I ] \ )
| Contour ... [E)Legend / :'Q.L\-: // -2.85500=-01
! () values / \ / <
1 Apply Close - s,: % % %
St _— s

R

7N

i,

i % % # k‘ ST: EXP
I %\ < G

VIEW-DIRECTION

w

W
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Step

(!B 10-1. Concrete Design Code

Procedure

Design Tab > Concrete design

parameter>Design code

Pushover

Load Results

d

Node/Element Properties Analysis Design

- ]: 15456:2000 -

+= Meshed Design ~

Boundary

E} Displacement Optimal Design...
L3 Section for Design

|SSRC79 5iQ Steel Design

SRC Design ~

115:800-2007

@ Design code: IS 456:2000
ar, Steel Design ~

If want to Go for ductile detailing General Design
Parameter ~
Then click on Apply 1S13920:2016

LFQ Concrete Design
[Q SRC Design

Design Result

Caoncrete Design Code X

1
Design Code : | 15456:2000

("] Apply Special Provisions for Seismic Design
MAT Properties

Factor of Safety for Soil : 3
Modulus of Subgrade Reaction : 15000 kN/m?=
Moment Redistribution Factor for Beam : 1

[ ]Torsion Design
P-M Curve Calculation Method
© Keep P Constant

() Keep M/P Constant

www.MidasUser.com



http://www.midasuser.com/

Step

y{IN 10-2. Modifying Concrete Material

Procedure

Design Tab > RC Design >

Modify Concrete Materials Modify Concrete Materials X

Name  fc|fck|R  Chk  La... Main... Sub-bar }
M30 30000 X 1 Fe415  Fed415 :

@ Select material ID #1
Rebar Selection - — M40 _ 0000 X 1 Fedls Fedls I
Code > IS(RC)
Grade of Main Rebar > Fe415

Grade of Sub-Rebar > Fe415 Concrete Material Selection
Code : IS(RC) & Grade : M40 e
. . Specified Compressive Strength (fclfck) ;40000 kN/m?2
Accordlng o that mOdIfy other (" Light Weight Concrete Factor (Lambda) : 1
property Rebar Selection
Code : IS(RO) 4
Grade of Main Rebar : Fe415 v By : 415000 kN/m2
Grade of Sub-Rebar : Fe415 ~ Fys : 415000 kN/mz
Modify Close

www.MidasUser.com



http://www.midasuser.com/

Step

10

10-2. Design Criteria for Rebar

| Design Criteria for Rebars X |

Procedure o For Beam Design

DeSign Tab > RC DeSign > Main Rebar : P20 Rebar...
. . . Stirrups : P10 e Arrangement : 2 b
Design Criteria for Rebar e ar e »
dr : 0.04 m dg : 0.04 O

B8 consider Spacing Limit for Main Rebar

@ Fill in the details as per

. Spliced Bars : Onone  (O)50% () 100%
Reqwrements for every
Structural element For Column Design
Main Rebar : P20 Rebar...
Ties/Spirals : P10 e Arrangement 1 ¥: 2 v
@ Click on Input Additional Wall do : 0.04 m e
Data B8 consider Spacing Limit for Main Rebar
SplicedBars: ~ @None () 50% () 100%
. For Brace Desi
@ Select any End Rebar Design o paes e
Main Rebar P20 Rebar...
Method Ties/Spirals : |P10 V Arrangement : y: 2 w
do : 0 m z: o -

B consider Spacing Limit for Main Rebar

splicedBars:  @nNone () 50%: () 100%
For Shear Wall Design
Vertical Rebar z P12 Rebar...
Horizontal Rebar : |P10 ~ EndRebar From : P10 =
P10
0.2
0.1
I de : 0.04 9 dw @ _0.03 m
T T

Close

Input Additional Wall Data x

| Design of Out-of-plane Bending
Spacing of Wall Rebars

Spacing of Vertical Rebars : @100,@150,@200,@300,@400 Space...
Spacing of Horizontal Rebars : From 0.05 m
o.én'd'ReEaT:TesTgn'nTeuTnE"""""""""""""‘.
Kot Used © Method-1 '
huto Calculation : (_1 Method-2 _ Method-3 (_) Method-4 :

Spadng of End Rebar

End Rebar Q'ty = 4 End Rebar Q'ty >= 8

End Rebar Q'ty = 6

] ! [
dd dDisN b 4 ADIst 2 b 4 & dDist 3
Dist1 : I m Distz:  0.15 m Distz: 0.1 m

oK | Cancel
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Step

(I8 10-3. Design Output (Beam)

15456:2000 RC-Beam Design Resu... — X
Procedure 1. Design Information

. . Code : 15456:2000 Unit : kN m Mlerrier bumbes 2
Design Tab > RC Design >
M-E;b-E-r} Dasagn Code 15430 2000 Lina Sy i MM
; Sorted by = = == sl Data - - v = s
Concrete Code deS|gn > Ories Y OPmperty Materal Dat ok = J0000. # 413000, # 415000 KP
Seclion Property  Bearm (Mo 3) Bezm Span 4m
. MEMB Section fck
Beam Design SECT | SEL| Bc | Hc fv |POS C: |
| Span bf | hf fuy e v mez
1 Beam 300000 | | |OK T - o
3 r [0.2300[0.7000| 415000 =
0 Sorted by > Member (on)> 0.0000[0.0000] 415000
Graphic ° ¢ °
Ber 300000 | | i b i
: : o 0.2300/0.7000] 415000 | M L a L
@ Graphic to see section detailing 20000 0:0000[0:0000] 415000 T J TOK
4 Beam 300000 | | |OK
3 I~ [0.2300 ﬁ].TODU 415000 M |OK TOR 31220 TOS I-PT TOR 3530
H H H 80T 28220 BOT 2P0 80T 2820
Similarly Design The column 40000 D“Ugg]';ﬁ?m oo LK STiRmmS 2010 @30 SRS 2810 @300 Friees 210 @19
3 r [02300[0.7000] 415000 | M |OK
And Shear wall. 40000 0.0000/00000] 415000  J |OK 2. Bending Moment Capacity
6 Beam 300000 | | |OK . T
3 I [0.2300/0.7000| 415000 | M |OK —
4.0000 0.0000/0.0000| 415000 | J |OK i) Load Combanation Mo e »» el
7 Be%m 30000.0 (e arrsnt (b} 7880 3206 81.35
3 I [0.2300[0.7000 415000 | M | Of
4.0000 0.0000[0.0000] 415000 | J | Ol st Siewngits (MR rEEm = 1R
8 Beam 30000.0 | OK Check Ratie (s Bd) 05874 o 3387 05058
3 I~ [0.2300[0.7000 415000 | M | OK
4.0000 0.0000/0.0000] 415000 | J | OK
g Beam 300000 | 0K (+) Load Cormbanaticon Ma iz 4 35
Select All Unselect All Re-calculation Check Ratic (Mt Rd) 04401 03040 03538
% Graphic... I Detail... Summary... >>
X i i N Required Rebar Top (As op) 0.000-4 00003 0.000-4
Option for Detall Print Position Update Rebar Required Rabar Bot (hs.bot) . LG P
@endl. ((Imid. [ JEndJ. Close
3. Shear Capacity
END-1 e END-J
Laoad Combenaticn MNo 28 a4 a4
Factared Shear Faros (Vu) 532 87 4891 57 61
Shear Strengih by Cono(Vaol o743 a7.43 o743
Shear Strengih by Rebar (V) 11904 119.04 116 .0
quulrucl Shear Reant (Awv) 00005 0 0003 0.0005
Reguired Sirrups Spaang 2-P10 F300 2-P10 @300 2P0 Sa00
Chaok Ratho 02833 oasz3 03085
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Step

10

10-3. Design Output (Beam)

Design Tab > RC Design >
Concrete code design >
Beam Design

€@ VMember(on) > Click Detail...

9 Confirm Detail Calculation report
as per 1S 456:2000

Procedure 1S456:2000 RC-Beam Design Resu... —

Gen 2024

S-th 0.08s 255.03 226.77 37.54
&-th 0.08 229.53 226.77 g3.78
7-th 0.08 216.78 226.77 95.59
g-th 0.088 223.15 226.77 .41
S-th 0.08 226.34 226.77 499.8
{ ). Compute ultimate moment of resistance.
-. & = betal * X = 0.0734 m.

. M Rd = alphal*fcd*a*Bc*(d-a/2) =

134.2903 kN-m.

{ J. Check ratic of negative moment resistance.

. Bat N = M/M Bd =

0.587 < 1.000 --—-> O.K.

[LI*111

Side rebar check

[

Check side rebar requirement.

. Hec <= 0.7500 m.

He = 0.7000 m.
——-> Side Face Bebar not required.

[00*111

ANALYZE SHEAR CAPRCITY.

Code : 15456:2000 Unit : kN
© Member
Sorted by OPere ty
MEMB Section fok CH
SECT | SEL| Bc He fy POS|
| Span bf | hf fuy
1 Beam 300000 [ | |OK
3 | r [02300]0.7000] 415000 | M |OK
4.0000 0.0000/0.0000] 415000 | J |OK
2 Beam 300000 | | | OK
3~ [0.2300/0.7000] 415000 | M  OK
4.0000 0.0000/0.0000/ 415000 J OK
3 Beam 300000 [ | |O
3 |  [0.2300[0.7000[ 415000 | M |0
4.0000 0.0000[0.0000] 415000 | J |OK
4 Beam 300000 | | |OK
3 | I [0.2300]0.7000[ 415000 | M |OK
40000 0.0000[0.0000] 415000 | J |OK
5 Beam 300000 | | |OK
3 | I [02300[0.7000] 415000 | M |OK
4.0000 0.0000[0.0000] 415000 | J |OK
6 Beam 300000 | | |OK
3 | ™ [0.2300[0.7000| 415000 | M |OK
4.0000 0.0000[0.0000] 415000 | J | OK
7 Beam 300000 | | O
3 | I [0.2300[0.7000[ 415000 | M |O
4.0000 0.0000[0.0000] 415000 | J | O
8 Beam 300000 | | |OK
3 | I [0.2300]0.7000] 415000 | M |OK
4.0000 0.0000[0.0000] 415000 | J |OK
9 Beam 300000 | | |OK

. Gammz m = 1.50

{for concrete).

(] Connect Model View

Select All omselect Al Re-calculation
===

Graphic... —_ _De_ta&.._ - summary... >>
Option for Detall Print Position Update Rebar
@endl. ((Imid. [ JEndJ. Close

-. fcd = fck / Gamma_m =  20000.000 KEPa.
-. Gamma_m = 1.15 (for reinforcement).
-. fyd = fy / Gamma m = 360869.565 EKFa.

{ J. Calculate shear strength of concrete.

-V = 52.873 kN.
-. b = 0.230 m.
- 7 =V / (b*d) = 364.8930 EPa.
-. B3 bvd = l00*Rs/(b¥d) = 0.43388 (Area of tensile reinforcement).
-. VC = 465.513 EPa. [I5456:2000, Table-19]
{ }). Calculate required shear reinforcement. ( Asvl = 0.00008 m~2. )
-. v_lim = 3500.000 EPa.
-. Bav/sl = 0.4%bv S (0.37%fyv) = 0.00025 m*2/m.
-. Calculate spacing sl = 0.6l6l4 m.
-. Smaxl = 0.30000 m.
-. Smax2 = 0.75 * d = 0.47250 m.
-. Applied spacing sv = MIN[ =1, Smaxl, Smaxi ] = 0.30000 m.
-. Hleg = 2
-. Asv = N_leg*RAsvl / sv = 0.00052 m~2/m.
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Step

10

10-3. Design Output (Column)

Procedure 15456:2000 RC-Column Design Re...  —

Design Tab > RC Design >
Concrete code design >
Column Design

@ Sorted by > Member (on)>
Select a member>Graphic

X
Code : zga5:2000 Unit : kN , m
{© Member |
Sorted oy O p;p:m,-
MEMB | Section fek fy
secT | SB[ Be | He | Heigm | _aw | % |
200 r Podium Colum 40000.0 | 415000 oK
1 0.4500[0.4500] 3.0000 | 415000
201 | ~ [Podium Colum 40000.0 | 415000 | ¢
1 0.4500[0.4500] 3.0000 | 415000
202 | ~ [Podium Colum 40000.0 | 415000 | ¢
1 0.4500[0.4500] 3.0000 | 415000
203 | ~ [Podium Colum 40000.0 | 415000 | ¢
1 0.4500[0.4500 3.0000 | 415000
204 | ~ [Podium Colum 40000.0 | 415000 | ¢
1 0.4500[0.4500] 3.0000 | 415000
205 r Podium Colum 40000.0 | 415000 OK
1 0.4500[0.4500] 3.0000 | 415000
208 v Podium Colum 40000.0 | 415000 OK
1 0.4500/0.4500] 3.0000 | 415000
207 r Podium Colum| 40000.0 | 415000 OK
1 0.4500[0 4500] 30000 | 415000
208 r Podium Colum 40000.0 | 415000 oK
1 0.4500[0 4500] 30000 | 415000
209 r Podium Colum 40000.0 | 415000 oK
1 0.4500[0 4500] 30000 | 415000
210 r Podium Colum 40000.0 | 415000 oK
1 0.4500[0 4500] 30000 | 415000
211 r Podium Colum 40000.0 | 415000 oK
1 0.4500[0.4500] 3.0000 | 415000
212 r Podium Colum 40000.0 | 415000 oK
1 0.4500[0.4500] 3.0000 | 415000
213 r Podium Colum 400000 | 415000 oK
1 0.4500[0.4500 3.0000 | 415000
214 | ~ [Podium Colum 40000.0 | 415000 | ¢
1 0.4500[0.4500] 3.0000 | 415000
215 |~ [Podum Cour} 400000 | 415000 | ¢

[ Connect Model View

e&elect All Unselect All Re-calculation
v Graphic... | Detail... Summary...
I —
Draw PM Curve... Update Rebar Close

>

3

Load Combnation . 31 (Pos | J)

UNITSYSTEM - kN, m

fo = 40000, & = 415000, #fyv = 415000 KPa

Ast= 00018852 ' (pst = 0 009)

. Design Condition
Desgn Code 15436:2000
Member Number 200
Matenal Data
Colurmn Height Iim
Section Mroperty Podium Column (No 1)
Rebar Pasern 6-2-P20
. Axial and Moments Capacity

048

ey

Concentric Max. Axial Load P Rdrrax = 3T3402KN 048 4
Axial Load Ratia Pu/PRd = 106.220/201.781 = 0.364 < 1.000 oK
Mormant Ratic M/ MRd = 638155/171 914 = 0371 <1000 oK
My / MRdy = GATTE5/1T1 800 = 0371« 1000 OK
M/ MRdz » 223001 / 6.01467 »0371<1000 ___ OK
M-N Intaraction Diagram
NikN)
4300 ke P.Rd(xN) MRA(kN-m)
Wy e 8=2.00"
F32 7] ..........}.\._. SEELEE P T e 4207 .30 0.00
3450 s 2646 73 1013
03 . 4510 192 12
3 g ¢ 2680 05 4202
. R 2261 68 276 61
s \ 1914 51 290 05
1380 / 1743.33 303 58
o 1610.24 303.01
1360 65 20677
s 1073.04 276.51
=24 T 700.70 234
- 18.19 120 92
20 8-3R23 328 £80.31 0.00
gIm'w o e " "v "} " a
Shear Capacity
[0 ) yOCH: 20,P0S 1 TILCH: 31, POS )
Appled Shear Foree (Vu) 199440 kN 352132 kN

Design Shear Strength (VetVs)
Shear Roto
Asv-H req

[ MODLE )

Appled Shear Force (Vu)
Design Shear Strength (VetV's)
Shear Rato

Asv-Hreq

137400 + 78,2453 = 215645 kN
0092 < 1.000 oK
0.00034 né/m, 2-P10 280

y(LCB: 29 POS: 1)
199440 kN

138127 + 782453 = 216 372N
0002 « 1.000 oK

0.00054 rfrm, 2-P10 @280

128085 «» 782453 = 206 330 N
0471 <1000 oK
0.00054 mim, 2,10 @280

2ILCB: 3%, POS:12)
352132kN

128 521 + 78.2453 = 206 767 AN
0,170 « 1,000 [T

0.00054 réim, 2-P10 @280
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Step

/{18 10-3. Design Output (Wall)

Procedure

1S456:2000 RC-Wall Design Result Dialog ~ — X 1. Design Condition
Design Tab > RC Design > S Unit - KN " Design Code I15438:2000 Unii System kM, m
y T ——— —— . g
. 1 Wall I 1 (Wall Mark w0001
> 10 vall ID + Story
Concrete code design Sorteawr” e L 2 T oy \2F (mighte 30
i - & =41 -
Shear WaII DeSIQn SE| m ok i ch Faterial Data ok = 40000, # = 415000, #v = 415000 KPa fj‘
| Story | L Lw HTw hw fuy K Wall Dimn. {Lengih®Thi) : 450,23 m n v =
- w0011 400000 | 415000 |5y " [
10F 20000 | 30000 | 0.2300 | 415000 Verscal Rebar P13 @400 (Asy = 0.000587 mbm) o2y - -
12 |- w0012 40000.0 | 415000 | - |
@ Sorted by>Wall ID + story 10| 2o Lsoan | oz 415000 2. Axial and Moments Capacily LN
: 11E 40000 | 30000 | 02300 | 415000
and select a wall>Graphic e b U000 02000 17000 — Consensric M. Axisl Losd PRoma  =483720 kN
1F 4.0000 | 3.0000 | 0.2300 | 415000 (LCB: 33 POS: LCE: 33 POS:
r wmr‘mos 40000.0 | 415000 | e 2 A i LW <
. .. 40000 | 3.0000 | 0.2300 | 415000 .
Such a window explaining the - WhDD09 400000 | 415000 [er Pru (x84} 16200 116200
. . 40000 [ 30000 | 02300 [ 415000 P.Rd (kM) 5TEI 36 0. Bo000
design would be displayed - wMO010 400000 | 415000 [y,
2.0000 | 3.0000 | 0.2300 | 415000 Pu/F.Rd 0.202 < 1.000 ... OK 0.000 € 1.000 ... DK
- 40000.0 | 415000 | ) .
02300 | 415000 M (kM=) 696.01 0.00000
" 02500 42000’ MR () —_— o 00000
i bR 8.303 < 1.000 ... OK 0,000 < 4000 OK
r w0002 40000.0 | 415000 | e
40000 | 30000 | 02300 | 415000 MRML 200 Lo S,
w0003 400000 | 415000 |-,
2F | 40000 | 30000 | 02300 | 415000°F 7S o vona BRI R s P
9 400000 | 415000 | ~ys
1z | a4 I 0.2300 | 415000 |0 e e
10 [ w0010 400000 | 415000 | - e —
12F 20000 | 30000 | 02300 | 415000 I I
- w0011 400000 | 415000 |,
12F 20000 | 30000 | 02300 | 415000 800 Tase
[ 2| ootz 400000415000 o - B - -
[ Connect Model View f— ﬂﬂ_,ﬂ-.-r' —
Select All Unselect All Re-calculation nmoo ﬁ,—r" e _
) merilD npong
.eGraphic... -! Detail... summary... >> <& B kM- & =3 [X°TY )
Draw PM Curve... Update Rebar Close e E E 2 i E g E E 2 E = 22 s Er R =73 2
a L - : - - o -2 HER AT F
3. Shear Capacity
Apphed Shear Fonoe Wu = 3THET4EN (Load Combination : 28)
Diesagn Shear Strength Veos = 2054 69 + 5T5.846 = 267054 kN
(Asv-H_req = 0000530 mim, P10@315)
Shear Raho Yu.Rd =041 =1.000 oK
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Step

y&8 11-1. Ductile Design

Procedure

Design Tab > RC Design >

View Structure Node/Element Properties Boundary Load Analysis Results Pushover Design

Design Code [E 115:300-2007 |SSRCT9 ~|| =¥ Displacement Optimal Design... | 7Q Steel Design
C S{:, Steel Design ~ @, SRC Design ~ E% Section for Design [.FQ Concrete Design
General Design ST [EQ SRC Desi
. % +=+ Meshed Design ~ & C Design
o Check on Apply Special Eatametcs 3

.. . . . Design Result
Provisions for Seismic Design

Concrete Design Code X
€©) Click Apply 1S13920:2016
Design Code : 15456:2000 v
e Check Consider Boundary o "W oo Specal rovsons fo Seemic boon |
0 fl R AL LA T v L
Element deS|gn Wlth MethOd A Ductile Design Code for Seismic Zone I, IV or V.
() Apply 1S13920:1993,
e I:o-.\\p-p\y- rs?ag'zn?zn'm.'}
o CI|Ck OK tTCt;sEer-stErEaumnfweak beam ratio

Consider strong column-weak beam on last floor

[ e e e -
B icConsider Elounda.lz Element des\iﬂn? 1
EF:conx eitioimcacdElmenHEceRET |

I © Method-A () Method-8
— - I
Shear for Design
Update by Code
Method
COmaxpvui,vuz) (I MIN(VU1,Vu2) Ovii Owvuz
Vul, Vg + al*SuM(Mu)/L ,al= 14
YuzZ, Vg + az*veq yaz= 1
MAT Properties
Factor of Safety for Soil : 3
Modulus of Subgrade Reaction : 15000 kN/m?=
Moment Redistribution Factor for Beam : 1

[:]Torsion Design
P-M Curve Calculation Method

O Kkeep P Constant

(") Keep M/P Constant

www.MidasUser.com



http://www.midasuser.com/

Procedure

@ Ciick Front View

e Select the Top floor elements
as shown using Select window

e Click Activate

Step
11-2. Ductile Design (selection of elements)

P 0N T-[z h ERDR R [B] 2] | By 2N K| w o7st01018  [5] TR 210902212

R - FLLIREE T

I
I

HH

SuEEE

-

—

L.t
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Step

158 11-3. Ductile Design (Wall)

Procedure

Boundary Load Analysis Results Pushover Design

View Structure Node/Elem e Properties

@ Ciick Select Al 1 emm St S — T
[_ o} 15:800-2007 T ||y [15456:2000 T i | ISSRC79 ~ || agy Displacement Optimal Design... | Q) Steel Design
EX B : ! - T secti | & ~
Desian Tab > RC Desian > E(:, Steel Design ~ L[% RC Design ~ 1 Q, SRC Design ~ %Secﬂon for Design Q Concrete Design
g g General Design --M -h-d D- momn Lol EASREDH
: ‘Meshed Design ~ = esign
Concrete Code Design > Wall Parameter ~ = Q =
Design
LR RN - A 1 PR R IR - F = S I YT
€ Click Wall ID + Story B Mt it s s
1S456:2000 RC-Wall Dey log -
B AR e A-rER e MB
Select the wall members Code : 15456:2000 Unit: kN, mm Primary Sorting Option
|------q 56:2000 & IS13920:201€¢ ] Method 1 & A Gen 2026
S © wall ID +Story | | Own  ©story
y I'UWEMB'(Wim' — Sort Result...
e Click Detail... or Graphic ... to WiD Wall Mark fok % | Ratio Tl Vu | AsV | V-Rebar | End-Rebar | BE.| BEH-Rebar | BEV-Rebar
SEL Pu - Jesign & Analysis Software) |
. Story Lw I HTw hw fyv Rat-V LCB LCB | Asv-H | H-Rebar | BarlLayer |LCB BE-L B.E.-Ratio 1g system for windows |
generate the deS|gn report. 1 wh0001 0.04000 [ 0.41500 [ 0.247 1055629 265.579 | 754.00 | P12@300 |  MNotUse - Not Use Not Use = -
I3 337.073 /Wall) Analysis and Design 1
16F 4000.0 | 30000 | 230.00 | 0.41500 | 0.282 33 25 | 61569 | PI0@255|  Double E B = »code2, ACI318-19, )
0 | | 3-14, ACI318M-14, ACI318-11, |
-05, ACI318-02, ACI318-99, I
T Endabohlofl el Staled PRt el Chacl/tncsd — moct ;. s -89, NSR-10, CSA-A23.3-94, I
3 w0003 0.04000 | 0.41500 | 0.247 1055629 | 265.579 | 754.00 | P12@300 |  NotUse S Not Use Not Use %9, GB/TS0010-10, |
ier | T 20000 [ 20000 [ 23000 [os1s00 | 028z | 0 [ 28 | 61569 | PI0@255|  Doub 2000, B18.41.20.: 2022, !
0 ] : - £ - ; @ I - . - KCI-USD12, KCI-USDO7, |
9 w0009 0.04000 | 0.41500 | 0.532 1270699 494.151 | 754.00 | P12 @300 |  NotUse = Not Use Not Use %9, KSCE-USDS, AIK-USDS4, |
e | T [Zo00 [ 3000.0 [ 230.00 | 0.41500 | 0.470 MRS = 42 | 61569 | PIO@255|  Double = = = Pz, TRHUSDI00, TWM-UsDIZ, |
= 2 a 2 = . iC(2023), NTC-DCEC(2017), I
10 [ - w0010 0.04000 [ 041500 | 0928 [ [ 618395 [354.966 | 1131.0 [ P12@200[ Notuse = Not Use Not Use (C)SINCE 1385 |
16F 20000 | 3000.0 | 230.00 | 0.41500 | 0.991 2 42 | 39250 | PI0@400|  Double = B = w— p—
e w0011 004000 [ 0.41500 | 0928 |, [ '618395 354965 | 1131.0 | P12@200| NotUse = Not Use Not Use Team |I
16F 2000.0 | 3000.0 | 230.00 | 041500 | 0938 |~ 26 42 | 39250 | PI0@400|  Double = : = = |
lasUser.com
12 | - w0012 0.04000 [0.41500 | 0582 [ | 207158 [ 162631 | 56550 [ P12@400 [  NotUse z Not Use Not Use
16F 2000.0 | 3000.0 | 230.00 | 0.41500 | 0.494 | 32 28 | 39250 | P10 @400 |  Double E : 2 I
5 WITH SCALING UP FACTORS.
+ Loadcase Name(Factor) + Loadcase Name (Factor)
3 SIDL( 1.500) + LL( 1.500)
(3 SIDL( 1.200) + LL( 1.200)
N
() Connect Model view o Result View Option Result View Option (B.E.) ;) SIDL( 1.200) + LL( 1.200)
Select All L Un>e All Re-calculaﬁonr Oa Ook ONe Ol v SIDL( 1.200) + LL( 1.200)
- - ) :
Graphic... 1 Detail... -! Summary... 1 < ll (O Required }) SO, S i ia
Draw PM Curve... Update Rebar Close Copy Table ONot Required 3) SIDL( 1.500) + WX( 1.500)
P T3 puy 2.9vv) SIDL( 1.500) + WY( 1.500)
0047 g 1 DL( 1.500) + SIDL( 1.500) + WX(-1.500)
0048 9 1 DL( 1.500) + SIDL( 1.500) + WY (-1.500)
0049 10 1 DL( 0.900) + SIDL( 0.%00) + WX( 1.500)
50 11 1 DL( 0.900) + SIDL( 0.900) + WY( 1.500)
051 12 1 DL( 0.900) + SIDL( 0.900) + WX (-1.500)
52 13 1 DL( 0.%00) + SIDL( 0.%00) + WY (-1.500)
53 14 1 DL( 1.200) + SIDL( 1.200) + LL( 1.200)
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Step

5B 11-4. Reinforcement Area (Graphical View)

Nelmdek =

View Structure Node/Element Properties Boundary

Procedure

@ Ciick select Al

Load Analysis Results Pushover

[ 115:300-2007 ~ || |1s456:2000 -] | [ssrcr ~|| =¥ Displacement Optimal Design...
———_
. ., Steel Design ~ RC Design ~ SRC Design ~ X i i = 1
e Check on the Reinforcement T 5(, ig % g Q, ig é Section for Design Q Concrete DesngnI

+=+ Meshed Design ~ TQ SAt Destan

Parameter ~
H Design Result
€ Click Apply g

Concete Design Result ~

Load Cases/Combinations
ALL COMBINATION v

Ratio by Components
(O Axial
(O)Shear-y (O Shear-z
()Rend-y (O Bend-z
© Combined N 5,

Type of Display
Contour ... Legend

v alues s
W@ e
o ebar O Biea (O Ratio(%) 8 »“' :
Diplay
Beam 8 column
@brace B wall
Output Component
Ratio of Axial STess
Main Rebar
8 shear Reinforcement

Column Section Size
Scale Factor 1

Value Option
Decimal Pt. 2 Dexp.

Output Section Location (Beam)
[ Certer ]

Max All
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Step

Design

Pushover
% fﬂ Generator
% Image

Design+ )
% Auto Regen.

Results

Load lysis

'&B 11-5. Bill of Material

Z. Ed Ehzszzzs

o TOOIS tab > B|” Of Material Unit  F eferences Sectional Property Earthquake midas
System Calculator Scaling GSD Convert Meta Files to DXF Files

Master
Design

Customize  Full
- Screen

Text Graphic
Editor Editor

MGT
Command Shell

Check all the boxes and click
OK Reinforcement

BILL OF MATERIAL

X

Bill Of Material .
BEAM & TRUSS BOM TYPEl SECT ID,SECT NAME, MATERIAL Unit System :

Select BOM outputs

-
_Bean’l-TI’USS E|e|'l'|e|'|t BOM typel Sigf SECTION NAME . H.!\TERIA;.‘ DENSITY LENGTH Im“P:IR\Iln AROEAUTER WEIGHT
Beam-Truss Element BOM type2 | ot

3 Beam 1 M30 2.360e+01 6€.016e+03 0.000e+00 1.119%+04 2.286€e+04
Beam-Truss Element BOM type3 I 1 Podium column 2 M40 2.360e+01 4.320e+02 0.000e+00 7.776e+02 2.065e+03
Plate type Element BOM 1 2 Building colum 2 M0 2.360e+01 1.632e+03 0.000e400 3.590e+03 9.244e03
BOM by Material 1 STMMATION : 8.080e+03 0.000e+00 1.556e+04 3.417e+04
e
.
BEAM ¢ TRUSS BOM TYPE2 SECTION NAME, MATERIAL Unit System : KV , x

Output Options SECTION NAME MATERTAL DENSITY LENGTH PAINT ARER WEIGHT
D TYEE HAME INNER OUTER

™ Tn<ert form feed svmbol st each oytotend -~ TTTTTTTTTTTTTTTTTTTT TTTTTTT 7T
@ nsert form feed symbol at each output end 3zam 1 cwM0 2.360e+01 €.016e403 0.000s+00 L.11%e+04 2.286e+04
3uilding column 2 cmo 2.360e+01 1.632e403 0.0002+00 3.590e+03 9.2442+03
File Name : D:\05.11 Work\Model file.bom browse Podium column 2 Cmo 2.360e+01 4.320e402 0.0002+00 7.776e+02 2.0652+03
SUMMATION : £.0908403 0.0002+00 1.556e+04 3.417e+04

—— -

e oK : Cancel
Emmmm—=— »
BEAM & TRUSS BOM TYPE3 SECTION NAME Unit System : kN , ¢
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Step

1WA 12-1. Initialization of workspace

Procedure

@ Create a new file
@ Set the unit system to Sl

€ Set Design code to IS
456:2000

(4) Update the Rebar to IS

e e
S R
e Cota {Go |

Recent Files
1 Foundation.mdpb

E D New (Ctrl+N)
Create a new document

Save
=
==

- Import...

_} Export..

£

Batch Print...

g,

Tool

Option

Quantity

Drawing Quantity |

Exit Design+

g o
{3 orawing option
EW Report Option
g

=3 i
2006 [ Al g e Dchlop WIDAS\ G\ o S\ D | - Mt |

tene
A Nerber
e et Bt Do

RC | el 80 e | R |

| .. | Sue. | et | . Swyton v OldseidOs

4

midas DESIGN

SRC ALY

0. makterace pricd expres i S Gays).
ot mabterace pied expres 1 S5 cars).

D (8w ] oo

————
esmﬂ M |
4 1
==

S5

midas  Link
Link Option C

Simple Check
Mode Mode

Ul Mode midas Link
orkBar - 0
Add Mew Member
System  RC W
Type Column ( General ) i
MName

Add New Member

Keep Sect. & Bar Data

RC |Shee|| SRC | Aluminum | Reinforce

’% RC Design Procedure

R
103 Design Code : 15456:2000 |

B Live Load : 1602012
Rebar DB : IS

Design Option
D._g' Drawing Option
Report Option
Preference
----- e Slab
----- D Beam
----- Column

..... @ Column { General )
..... |$ Shear Wall

i .
----- it Footing
oL

Foating { Combined )
..... |EE. Basement Wall

..... I:l::ll Buttress

..... % stair

..... | corbel / Bracket

..... &ﬁ Retaining Wall

..... T Anchor Balt

E.l Beam Table

Z§ slab Table
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Step

W4 12-2. Slab optimization in DESIGN+

+
Procedure midas DESIGN
| ec [ ee [ sac [ au |

Click on Slab Section o= Ay + T M

Beam Columin Beam+Column Base Platz Comp. Beam Beam+Caolummn

)

Click on S01

+ =4 r + 1)
3
BasaE'%f%Wa\l Eolt%{x:’m Crff’de: Col UHJ Bea%.lmn
€ Click on Member >Section > 2
CheCk( F5) Buttress Purdin+Girth ~ Web Opening CFT Column
i _
Anchor Bolt Stair Code Table

‘midas Design+ 2026 - [ C:\Users\equba\OneDrive\Desktop\MIDAS\Gen\Sai Sir\Slab Design-+ * | - [ Member ]

WEC SRC
=Y 5 EBEE

Project| simple Check | midas Link Link || Member Member Drawing Quantity
Mode | Mode Mode | Link Option DataBase ist

Aluminum Reinforce  Load

Option  Tool  View

Ul Mode i o wm w_ Edlit MOGE
I:Member Member List *~ Drawing | CQuantity | -
‘Add New Member | eppe——— ] Bar (X Drection)
System |RC v Member Name 501 Ly Tor
Type (Siab F’*&D‘vﬂs Memberto  |Dwg&Report /4, Ly - Lx2 Ly MuCkum) o000 0K10.000)
Name I smmrJ Load | Vu (k) 0.000 OK(0.000)
Add New Mem. W o= o ; Rebar (X1) P10 @| 450.00
Keep Sect. &Bar Data F Rebar (2) P10 @| 450.00
Concrete El ~ | MPa M |
! Rebar (X3) P10 @| 450.00
RC | steel | sre | Auminum | Reinforce | Rebar 415 | mpa J | | 81 Y T o Conier
i R Design Procedure Light Weight Conarete K Hi— MIDDLE
Option P 1 X ‘ MU (kim ) 0.000 OK(0.000)
[ Design Code : 15456:2000 _—— T . Va (k) 0.000 OK{0.000)
[® Live Load : BC2012 StressStrain  ParabolaRectangle (Au o ! Rebar (1) P10 e| 45000
£ Rebar DB : IS Al % |
[ Design Opton Slab Type - Hetmir) P10 @] +0.00
I3 Drawing Option O 1waySlab © 2 way Siab 4 a ] EE(E8) P10 @ 450.00
-[B Report Option ) g J ! EE
EFEE”EE. Dimension = b} L — Mu (kN.m) 0.000 OK(0.000)
Slab (1) Span(x) Il ‘ ) vu (k) 0.000 Olc(0.000)
1 Span(y) em  0om —I o | XJ: Rebar (X1) P10 @| 4s0.00
Thickness 150.00 mm ' Rebar (x2) P10 @] 450.00
Cover 20 mm Rebar (£3) P10 @] 450.00
8 column (General) 8 Use dear span Rebar [~ Link to Center
[E= shear wall Bar Arrangement type
Footing 10 Type A" OType 8" OType T
Footing ( Combined ) Bar Arrangement (¥ Direction) Calculation Reslt
E’El :i:::::twa” LEFT CENTER RIGHT CHECK TTEMS RESULT
By s Mu{kn.m) |0.000 0K(0.000) (0.000 0K(0.000) (0.000 0K(0.000) Design type of slab 2-Way Slab
125 Corbel /Bracket Vu (k) 0.000 0K(0.000) (0.000 0K(0.000) (0.000 0K(0.000) Min. Thickness { mm ) -18.62
8 Retaining wal Rebar (Y1)  [P10 @ | 450.00 P10 @ | 450.00 P10 @| 450.00 [Min. Bar Ratio (mm?) 0.120% | 180
LM Anchor Bolt Rebar () [P10 @| 4s0.00 [F10 @| 40.00 [F10 @| 4s0.00 Max. Bar Space (mm) P10 | @450
[ 5eam Table Rebar (v3) P10 @| 4s0.00 [F10 @| 40,00 [F10 @| 4s0.00 short Deflection (mm ) - -
Slab Table Rebar [ Link to Center [ Link to Center Long Deflection { mm ) - -
ntol Check(Fs) : Repor Apply(F3)
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Step

12

12-3. Slab Loading Data

@ Click on “Load” tab

@) Enter the value of..

Dead Load= 2 kN/m3

Live Load= 3 kN/m3

© Click “Check(F5)’

Add New Member
System  RC
Type  Sb
Name
Add New Member
Keep Sect. &Bar Data

Member  Member List r Drawing r Quantity }

General
Member Name 501
Iy this Member to Dwg &Report

qL Load | ‘l

v

' ) 1
RC |Shee\ | SRC| Aluminum | Relnforce' § Dead Load 2 Wym i
i 3 2
fﬁ RC Design Procedure  Live Load . Kiyjm 1
B Opfion [Cuse User Tnput

g Design Code : 15456:2000
Live Load : [BC2012

& Rebar DB : IS

Design Option

ﬂ.—‘o Drawing Option

. @ Column { General )

- : Shear Wall

g Footing

Footing { Combined )
Basement Wall
Buttress

Stair

Corbel [ Bracket

- Retaining Wiall
. Anchor Bolt

- E.L Beam Table

Support Condition (2Way)
=

Boundary Beams

gy 40000, 60000 mm

g2 40000 600, o
BuseBt

g3 0000, 60000

B 40000, 60000
Busess

Das\ge Chedk(F5) Repor

Bar Arrangement (X Direction)

Ly TOP
LX[‘41 Ly - Lx/2 1LX1’4 Mu (kN.m ) 5.303 OK(0.353)
Vu (k) 5.750 OK(D.10)
Rebar (X1) P10 @| 450.00
Rebar (2)  |P10 @ 450.00
Rebar (X3) P10 @| 450.00
Rebar [ Link to Center
E MIDDLE
X Mu(km)  [4072 OK(0.271)
h Vu (k) 3,375 OK(0.054)
o o Rebar (1) |P10 @| 450.00
X Rebar (X2) P10 @| 450.00
i Rebar (X3) P10 @| 450.00
_E BOTTOM
X Mu(kim)  [5.303 OK(0.353)
Vu (k) 5.750 OK(0.109)
Rebar (X1) P10 @| 450.00
Rebar (7)  |P10 o 450.00
Rebar (X3) P10 @| 450.00
Rebar [ Link to Center
Bar Arrangement type
Ompew Oype v OType e
Bar Arrangement (Y Direction) Calulation Result
LEFT CENTER RIGHT CHECKITEMS RESULT
Mu(km) [3.110 OK(D.225) [2.333 OK(D.169) |3.110 OK(D.225) Design type of slab 2-\Way Slab
Vu (kN) 0.000 0OK(0.000) (0,000 0K(0,000) (0,000 0K(0.000) Min. Thickness (mm ) 12.57
Rebar (Y1) |P10 @ | 450.00 |P10 @ | 450.00 |P10 @ | 450.00 Min. Bar Ratio (mm?) 0.120% 180
Rebar (Y2) |P10 @ 450.00 P10 @ 450.00 P10 @ 450.00 Max. Bar Space (mm ) P10 @450
Rebar (Y3) |P10 @| 450.00 |P10 @ | 450.00 |P10 @ | 450.00 Short Deflection ( mm ) = =
Rebar [ Link to Center [ Link to Center Long Deflection (mm ) - -
Apply(F3)
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Step

V4 12-4. Design Option (Slab)

) Design Option
Procedure if eEEES-c - BE®w ——
: | Ratio ISecﬁonI RC(D) | RE(@ | R | shearwial | Steel | sRC | Reinforce
| Modeflink | RC  Steel  Si —_——
Go to Design Option L5 B - Materia RC -
5 E ™ | By Comp. Tens. Bending Shear Etc.
e o Member Type 3 ; - - -
. . Project| Simple Check midas  Link Member| Design Design Design Design Design
Tap “Rat|0" ICON Mode | Mode Mode Link Option D: Footing 1 1 1
Ul Mode midas Link .
v 1
Check on Slab H

@ © ® O 9

Add MNew Member m & I
System  RC » Column r
“ » Basement Wall r
Tap “RC(1)” icon T Sisb ~
p ( ) ¥ee Shear Wall r
MName Footing ( Combined ) r
“ H Add New Memb
Check on “Change section e T Batch Beam r
. . Keep Sect. & Bar Data Batch Col r
” a8 olumn
by Design” option, put Max. — =
a8 al
. _ RC ; )
Thick = 1000 mm | steel | sRc | Aluminum | Reinforce . :
I3 RC Design Procedure Design Option
; =-[E% Option o
@ Click OK [ Design Code : 15456:2000 _Ratio. I_Si W Rc_{_}lRE(z_) |_F‘£(_3).|I Shear Wall | Steel | sRC | Reinforce
B Live Load : 18C2012 i Siab i Footing
oF?‘%ﬂém '-T-'5—I : B change Section by Design : [ change Section by Desian
"ﬂ" _| L 8 Max. Thick 1000.00  mm | Max. Thick 2000.00  mm DSl
g Drawing Option R ——
-- Report Option ) OK Close
-- Preference 1 Column Stair
Slab (1) [T change Section by Design [ change Section by Design
=
e 501 Max. Width 2000.00  mm Max, Thick 500.00 mm
: tB:elam Max. Height 000,00
& olumn
= Max. Rhi 4.00 9 o
@ Column { General ) 4 S i Corbel/Bracket
: Shear Wall [ Use Design Method of Gen/ADS (L] Change Section by Design
Footing Max. Width 2000.00 mm
Footing ( Combined ) Basement Wall Max. Height 2000.00
el Basement Wall [l change Section by Design
Butiress
. Max. Thick 100000 mm ) ]
= ) Combined Footing
Corbel / Brac‘r‘ (] Apply Shear Reinforcement ([ Change Section by Design
tim Retaining Wal
- Max. Thick 2000.00  mm
AT Anchor Bolt o e e
[em Beam Table ]
Slab Table
i Default
| (6
| Default (al) : Close
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Step

W4 12-5. Design Result (Slab) & iteration

(= ] Design Result ( Slab )

Select rebar to apply

DIR-X DIR-Y
MIM.
Procedure S I > - 1 > -
, Qi : || Member | Memberlist | Drawing | 0w @lemdoooo [ 53021 072 | 5303 [ 21101 2353 [ 3110 [ 00,0002 ]
@ Click on “Section” tab>Design(F4) p—  |p10 @207 | @281 | @207 | @276 | @384 | @276 | @350
I — 501 [~ |Pio+12 @245 | @333 | @245 | @296 | @418 | @296 @350
13 ” ——
9 Check on “P10 P —— Dwg&Report r |p1z @289 | @393 | @289 | @350 | @450 | @350 @350
o [~ |P12+1s @375 @450 @375 @218 @450 @218 @350
[ayep——
i Secﬁon_l Load ™ |p16 @450 | @450 | @450 | @279 | §oo——==— —
9 C“Ck OK I- —— ) oa | Memb Member List r Drawing Qu
Material = —
@ Again go to “Section” tab T e Ol = = enbertane Frr——
9 9 Rebar 415 ~ | MPa Apply this Member to Dwg &Repart
4y
. e | Section { Load
@ Change the thickness to T =
Fackar
100 mm Concrete 2 | MPa
Stress-Strain Parabola-Rectangle (A Rebar s -2
@ CIle "CheCk(F5)" Light Weight Concrete
Slab Type Factor 1
() 1 Way Slab © 2 way Slab
Stress-Strain Parabola-Rectangle ( Ay
Dimension
4.00 Slab Type
Span(x) _ " () 1 Way Slab 0 2way Slab
Span(y) ew  om
Dimension
Thickness 150.00 mm
T = T
Cover ' mm 6.00
e o 1) I i
8 Use dear span e L Thickness 100 mm:
=T
8 Use dear span
o -

0' F_ Chedk(F5) Report ... DES\QH(@‘ Repart ...
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Step

W4 12-6. RC Slab Drawings

ET SEAE SRR
6]

Mode/Link

Steel SRC Aluminum Reinforce Load Option To

RC
Procedure S ﬁ = B @

Project | Simple Check midas  Link Link Member Member Drawing Quantity
Mode | Mode Mode Link Option DataBase List
@ Click on “Drawing” tab Ul Mode midas Link Edit ‘gt

[ -
Member r\dembe.ol_ Drawing | Quantity
Member Member List Drawing Quantity

=
o5 OFrame ~ |OByLayer ~ ByLayer | — BYLAYER ~ Snap | Grid | Ortho || Osnap || -2959.73, 792.88, 0.00

@ Check on “Create” option Add New Member

[ or

M!DASIT

— y RC SLAB LIST

—————————

Command:
‘.7.-.

RC | glab | create |l savess... Print List
L‘-‘-‘-‘-‘ﬂ
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Step

(V4 12-7. RC Slab Quantity Results

Procedure

Maode/Link RC Steel SRC Aluminum Reinfarce Load Option Tool
SR BEED
H “ PRl - . . . . - .
o Click on Quant|ty tab Project | Simple Check || midas Link Link || Member Member Drawing Quantity
Mode | Mode Mode Link Option DataBase List
. Ul Made midas Link Edit Made o
1] ” —— -
@ Check on “Create” option 3 1
| Member r Member List r DrawingL Quantity |
. ) y Add New Member | |
€ Click on “Export to Excel” >
Member r Member List r Drawing > Quantity v X
Excel Spreadsheet Secon
Direction X Direction Y
Mame | Thick Left Center Right Top Middle Bottom
(mm) | Repar1 | Rebarz | Rebar3 |Rebart| Rebarz | Rebar3 | Rebari | Rebarz | Rebars | Rebari | Rebar2 | Rebars [Rebari| Rebarz | Rebars [ Rebart | Rebarz [ Rebe
(mm ) (mm ) {mm) | (mm} | (mm) (mm ) {mm} {(mm ) (mm ) (mm ) {mm) (mm) | {mm) | (mm} {mm} (mm ) (mm ) {mn
S01 70.00 ( P10@400 | P10@400 | P10@300 - P10@500 ( P10@600 | P10@400 | P10@400 | P10@S00 | P10@500 | P10@600 | P1O@S00 - P10@700 | P10@800 | P10@500 ( P10@600 | P10
RC w | Slab 'L Create Export to Excel g Auto Resize # This tab show Quantity per Unit Length,
I \ Excel Spreadsheet 1
IThE project will be automatically saved. ﬁ TRl gargﬁagl
O S PR £2 duriod
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